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XBRi Installation Guide Overview 
This guide provides instructions for installing XBRi Ingenium 10.8.1 at a customer site. It is divided into 

four main Installation parts, appendices for application and mobile configuration and troubleshooting  

Part 1A Database Installation – Shows how to install Oracle databases for new XBRi Retail and 

Grocery installations and upgrade Oracle or SQL databases for current XBRi  Retail and Grocery 

users upgrading to XBRi.

Part 1B Database Installation – Shows how to install Oracle databases for new XBRi Food and 

Beverage installations. 

Part 2 I-Server Installation – Shows how to install the I-Server, which acts as middleman 

between database server and web server.   I-Server should be installed on a dedicated server. 

Part 3 Web Server Installation  – Shows how to install the web server, which hosts the XBRi

application. The Web server can be installed on a physical or virtual server. 

Part 4 Manual Configuration Steps – Provides all the manual steps required to configure XBRi

after installing the database server, I-server and web server. 

Organization Introduction – For new F&B Installations, explains how to run the Organization 

Introduction module. 

Upgrading from XBRi 10.7 to XBRi 10.8 

Upgrading from XBRi 10.8 to XBRi 10.8.1 

Appendix A: Application Configuration – Additional application configurations steps. 

Appendix B: Mobile Configuration – Explains how to configure installations of XBR Ingenium 

mobile app for the iPad and Android tablet. 

Troubleshooting – Identifies problems that could be encountered during and after the 

installation process and provides workaround steps. 

Prerequisites 
• Current XBRi customers must be running XBRi 10.7 before upgrading to XBRi 10.8. 

• Before installation, ensure that the Windows Control Panel – Region and Language Format is set to 

English (United States). 

Have the following information on hand prior to beginning an installation: 

• MicroStrategy License key 

• The location of the servers the customer will use to host the application 

• Database name, instance, and port number for the target server  

• Installation CD ROM with database scripts and metadata 

• Installation spreadsheet with database variables 

It is recommended to use database partitioning for optimum system usability. 
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Part 1A Database Installation – Retail & 

Grocery 
Note: SQL server is supported for upgrades of existing SQL server installations only and Oracle database 

must be used for new installations. 

There are two parts to XBRi 10.8 Retail & Grocery database installation; creating the database instances 

and running the database scripts. After you create the database instances, run the database script for 

the appropriate database type. The three database installation types are: 

New Oracle Installation

Upgrade Oracle

Upgrade SQL

New Oracle Database Installation (10g & 11g) 

Before you Begin 

It is recommended to use database partitioning for optimum system usability. 

• Have the installation CD Rom available with the database scripts and metadata.

• Make sure you have the installation questionnaire spreadsheet with the variables in 

PRO_SP_VARIABLES table completed and available. You will need this to enter ETL Database 

Variable settings. 

Create the MicroStrategy application databases 
These databases must be created before the I-Server or Web Server can be installed. 
Create a total of three database instances in the customer’s database server for the 
application using the following naming conventions: 

• APPMDXXX
• APPSTXXX
• APPHLXXX

Where
• APP = application file
• MD =  two-letter code to identify the metadata database 
• ST = two-letter code to identify the statistics database
• HL =  two-letter code to identify the history list database
• XXX = This code is the three digit PTS customer code that will also be used as org code 

during the install.

These three MicroStrategy application databases will remain empty. 
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Create the XBRi Ingenium 10.8 Oracle Data Warehouse Database 

Create one database in the customer’s database server for the Data Warehouse using the 
following naming conventions: 

• DWRGXXX
Where

• DW = Data Warehouse
• RG =  Retail & Grocery 
• XXX = This code is the three digit PTS customer code that will also be used as org code 

during the install.

New Oracle Database Installation (Oracle 12c)

For Oracle 12c, you will first create a Container database named XBRI, then the same four databases 

described above will be created as Pluggable Databases and plugged into the Container database. 

Methods to create the XBRi Ingenium 10.8 Oracle databases 

Create these four new Oracle Databases using the Database Configuration assistant, or ensure that a 

new instance and database has been created by the responsible DBA. 

To create the XBRi Ingenium 10.8 Standard Security in each of the 3 MicroStrategy databases: 

1. Update the tnsnames.ora and listener.ora with new database information. 

2. Create the Standard Tablespaces by opening a SQL Query window either through Toad, SQL Plus 

or other client interface tool, and attach to the newly created database. 

Open the database script Oracle_standard_tablespaces.sql from 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

The tablespace locations are set up by the Oracle DBA. You need to 
get the disk drive and directory where the Oracle data will be stored 
from the Oracle DBA. 

Ensure the tablespace locations are correct, then copy and paste the script into the SQL query 
window, and execute it.  

3. Open and execute the database script Oracle_standard_security_MSTR.sql  from 
CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

Run the Database Scripts 

After creating database instances, execute the appropriate scripts against the data warehouse

To create the XBRi Ingenium 10.8 Standard Tablespaces, Standard Security and database objects: 
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1. Log into the new instance with the “sys” account and password as sysdba. 

2. Update the tnsnames.ora and listener.ora with new database information. 

Create the Standard Tablespaces by opening a SQL Query window either through Toad, SQL Plus 

or other client interface tool, and attach to the newly created database. 

Open the database script Oracle_standard_tablespaces.sql from 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

The tablespace locations are set up by the Oracle DBA. You need to 
get the disk drive and directory where the Oracle data will be stored 
from the Oracle DBA. 

3. Ensure the tablespace locations are correct, then copy and paste the script into the SQL query 
window, and execute it.  

4. Open the database script Oracle_standard_security.sql  from 
CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

5. Locate the CREATE DATABASE LINK command at the end of the script and change MicroStrategy 
Metadata database name to be the TNS name of the metadata database name in your 
installation. 
Example: 

CREATE PUBLIC DATABASE LINK "XBRI_MD_CLONE.HST" 

       CONNECT TO XBRADMIN 

       IDENTIFIED BY "XBRADMIN" 

USING 'APPMDXXX'; 

Also provided in the tablespace script and initially commented out, is the 
addition of new parameters for implementing Transparent Data Encryption 

(TDE). It is highly recommended to use TDE for a secure data warehouse 
environment. It is also recommended that the security key used for 

encryption NOT be stored in the database, but in a secure wallet outside the 
database being encrypted. For information on encrypting your data 

warehouse database using TDE, copy and paste the following URL into 
your internet browser. 

https://docs.oracle.com/database/122/ASOAG/configuring-transparent-
data-encryption.htm#ASOAG10474

6. Copy the edited script into SQL Query window pointing to the Data Warehouse database. 
Execute the script to create the database roles and users. 

7. Log out and log back in to the database as user XBRADMIN. 
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Open the database script build_database_objects.sql from:

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

Copy the contents into the SQL Query window. Execute the script to create all the database 

objects tables, views, functions, stored procedures, triggers, and so on. 

To load the metadata: 

1. Load the XBRi 10.8 system table metadata. Open the metadata archive from  

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL\METADATA

2. Unzip the core metadata to a new or empty folder. The contents of the core metadata archive 
are the common formatted .DAT files, the format  files (.FMT, .CTL) and two load command 
files, one for SQL Server and one for Oracle. We will use the Oracle Server version for this load  
core_xbri_metadata_load_oracle.cmd 

3. Edit the command file core_xbri_metadata_load_mssql.cmd and set the database and file 
location variable to match the server and database you want to load

Example: 

Set XBR_DATABASE=DW_RG_QA 

Set FILE_LOCATION=D:\Metadata \XBRi 

Set DATA_FILE_LOCATION=D:\Metadata\XBRi 

Set USER=XBRADMIN 

Set PW=XBRADMIN 

4. Execute the command file by either clicking the file, or opening a command window and setting 
default to the FILE_LOCATION folder. This loads the metadata. There will be a log file for the 
deletion of rows from the target table tablename_DELETE.LOG and a log file for the load of the 
target table tablename_LOAD.LOG. At the end of the load, all the individual load log files are 
concatenated together so one log can be quickly scanned to see if there were any errors – 
databasename_LOAD_FULL.LOG

5. Execute the post new build cleanup script to convert sql server syntax in PRO_VIEW_SYNTAX 
and MD_LP_SMARTLINKS_FIELDS to Oracle.

Open the database script post_new_build_80_cleanup.sql from:

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

Copy contents into SQL Query window and execute the script for data warehouse database.

Post Database Installation Setup 

Execute the Security Script 
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Open and execute the security script: Oracle_standard_security_APP_ 

MD.sql 

The security scripts is on the release CD in the following location: 

CD: \DATABASE_SCRIPTS\UPGRADE\ORACLE 

To execute the security script: 

Open Oracle_standard_security_APP_MD.sql and execute entire script in the query window 

attached to the APPMDXXX database. 

Setting Start Time in the External Scheduler Table 

The next step is to set the External Scheduler kick off time by passing the hour and minute as 

parameters to the SP_LP_SCHEDULE_SET_TIME procedure. The following procedure uses the start time: 

11:45 pm. 

To execute the SP_LP_SCHEDULE_SET_TIME procedure: 

In the Query window, enter the following: 

DECLARE  

  PN_HOUR NUMBER; 

  PN_MINUTE NUMBER; 

BEGIN  

  PN_HOUR := 23; 

  PN_MINUTE := 45; 

  XBRADMIN.SP_LP_SCHEDULE_SET_TIME ( PN_HOUR, PN_MINUTE ); 

  COMMIT;  

END; 

Master Fiscal and Calendar Date tables 

The last step of the new database installation is to determine the Fiscal Date Calendar 

format and date range to create for the master date tables. If the customer is a retail customer following 

the standard NRF Fiscal Calendar 4-5-4 monthly format, you don’t need to execute this step; the default 

fiscal calendar that was loaded with the core metadata has already been generated back several years 

from fiscal year 2005 to 2030. 
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If the customer needs a different date range or uses the fiscal 4-4-5 format, you must follow the next 

procedure to regenerate the data in the master date tables. The parameters in the example below will 

generate the date tables from fiscal 2006 to 2013 with weeks starting on Sunday. 

To regenerate the date tables with a different date range than the fiscal 4-5-4 format:  

Change the parameters as needed. 

In the Query window, enter the following: 

Example: 

BEGIN  

  XBRADMIN.SP_MST_UPD_DATE_454 (1,'29-JAN-2006',2006,2013,7); 

  COMMIT;  

END;  

/ 

• The first parameter is the organization ID of the customer. 

• The first parameter is the date for the first day of the Fiscal Year according to NRF 
standard 4-5-4 calendar. Years supported are from 2000 to 2031. A 4-5-4 fiscal calendar 
cannot be generated using an invalid fiscal year start date. 

• The second parameter is the fiscal year to start the calendar 

• The third parameter is the fiscal year to end the calendar 

• The fourth parameter is the day of the week that starts the fiscal week. The default for 
the U.S. is Sunday, day seven, with Monday being day one. 

If the company supports the non-NRF standard 4-4-5 fiscal calendar, then all the same parameters apply 

to the 4-4-5 procedure, you just need to change “_4-5-4” to “_4-4-5” 

In the Query window, enter the following: 

Example: 

BEGIN  

  XBRADMIN.SP_MST_UPD_DATE_445 (1,'29-JAN-2006',2006,2013,7); 

  COMMIT;  

END;  

/ 
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ETL Database Variable Settings 

Check and set all database variables in PRO_SP_VARIABLES table according to 

the installation questionnaire spreadsheet that should have been already 

completed 

The database variables are: 

STORE_UNIQUE - determines if store numbers are unique across the organization  

EMPLOYEE_COPY - determines if cashier number is copied to employee number  

SALESPERSON_COPY - determines if cashier number is copied to salesperson number  

EMPNUM_USE - determines if employee number is used or always NULL 

SALESPERSONNUM_USED - determines if salesperson number is used or always NULL 

SKU_STAGE_OVERRIDE - determines in the SKU update if values from staging should override 

TMP 

CUST_STAGE_OVERRIDE - determines in the CUSTOMER update if values from staging should 

override TMP 

CASHIER_SIZE - determines the maximum size of the customers column which will be the source 

for   CASHIERNUM, EMPNUM, SALESPERSONNUM – this value is used in the calculation of the 

CASHIERID, EMPLOYEEID and SALESPERSONID column values. The max size allowable is 20 for 

CASHIERNUM, EMPNUM, SALESPERSONNUM and will control the sizing of all three of the ID 

columns. 

Oracle Database Upgrade – 10.7 to 10.8 

Before you begin 

• Upgrade scripts are on the release CD in the following location: 
CD:\DATABASE_SCRIPTS\UPGRADE\ORACLE 

• Ensure your database is currently at XBRi version 10.7 GA, this database upgrade assumes all 
previous upgrades have been completed up through XBRi 10.7 GA 

Upgrade Oracle Database from XBRi 10.7 to XBRi 10.8 

1. Run the following scripts in the order shown, “appl” before “data.” 
xbr_appl_107_to_108_upgrade.sql 

xbr_data_107_to_108_upgrade.sql 
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2. Copy/Paste each entire script into a SQL Query window and execute.  

SQL Database Upgrade – 10.7 to 10.8 

Before you begin 

• Upgrade scripts are on the release CD in the following location: 

CD: \DATABASE_SCRIPTS\UPGRADE\MSSQL 

• Ensure your database is currently at XBRi version 10.7 GA, this database upgrade assumes all 
previous upgrades have been completed up through XBRi 10.7 GA 

Upgrade SQL Server Database from XBRi 10.7 to XBRi 10.8 

1. Run the following scripts in the order shown, “appl” before “data.” 
xbr_appl_107_to_108_upgrade.sql 

xbr_data_107_to_108_upgrade.sql 

2. Copy/Paste each entire script into a SQL Query window and execute.  
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Part 1B Database Installation – Food & 

Beverage 
Note: SQL server is supported for upgrades of existing SQL server installations only and Oracle database 

must be used for new installations. 

There are two parts to XBRi 10.8 Food & Beverage database installation; creating the database instances 

and running the database scripts. After you create the database instances, run the database script for 

the Oracle database.  

New Oracle Database Installation (10g & 11g) 

Before you Begin 

It is highly recommended to use Transparent Data Encryption (TDE) for a secure 

data warehouse environment. TDE is only available in Oracle 11g and above. It 

is also recommended that the security key used for encryption NOT be stored 

in the database, but in a secure wallet outside the database being encrypted. 

For information on encrypting your data warehouse database using TDE, copy 

and paste the following URL into your internet browser. 

It is recommended to use database partitioning for optimum system usability. 

• Have the installation CD Rom available with the database scripts and metadata.

• Make sure you have the installation questionnaire spreadsheet with the variables in 

PRO_SP_VARIABLES table completed and available. You will need this to enter ETL Database 

Variable settings. 

• https://docs.oracle.com/database/122/ASOAG/configuring-transparent-data-

encryption.htm#ASOAG10474 

Create the MicroStrategy application databases 

These databases must be created before the I-Server or Web Server can be installed. 
Create a total of three database instances in the customer’s database server for the 
application using the following naming conventions: 

• APPMDXXX
• APPSTXXX
• APPHLXXX

Where
• APP = application file
• MD =  two-letter code to identify the metadata database 
• ST = two-letter code to identify the statistics database
• HL =  two-letter code to identify the history list database

•
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• XXX = This code is the three digit PTS customer code that will also be used as org code 
during the install.

These three MicroStrategy application databases will remain empty. 

Create the XBRi Ingenium 10.8 Oracle Data Warehouse Database 

Create one database in the customer’s database server for the Data Warehouse using the 
following naming conventions: 

• DWRGXXX
Where

• DW = Data Warehouse
• RG =  Retail & Grocery 
• XXX = This code is the three digit PTS customer code that will also be used as org code 

during the install.

New Oracle Database Installation (12c)

For Oracle 12c, you will first create a Container database named XBRI, then the same four databases 

described above will be created as Pluggable Databases and plugged into the Container database. 

To create the XBRi Ingenium 10.8 Standard Security in each of the 3 MicroStrategy databases: 

1. Update the tnsnames.ora and listener.ora with new database information. 

2. Create the Standard Tablespaces by opening a SQL Query window either through Toad, SQL Plus 

or other client interface tool, and attach to the newly created database. 

3. Open the database script Oracle_standard_tablespaces.sql from 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

The tablespace locations are set up by the Oracle DBA. You need to 
get the disk drive and directory where the Oracle data will be stored 
from the Oracle DBA. 

Also provided in the tablespace script and initially commented out, is 
the addition of new parameters for implementing Transparent Data 
Encryption (TDE). It is highly recommended to use TDE for a secure 
data warehouse environment. It is also recommended that the 
security key used for encryption NOT be stored in the database, but in 
a secure wallet outside the database being encrypted. For information 
on encrypting your data warehouse database using TDE, copy and 
paste the following URL into your internet browser. 

https://docs.oracle.com/database/122/ASOAG/configuring-
transparent-data-encryption.htm#ASOAG10474 
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Ensure the tablespace locations are correct, then copy and paste the script into the SQL query 
window, and execute it.  

4. Open and execute the database script Oracle_standard_security_MSTR.sql  from 
CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

Creating the New XBRi Ingenium 10.8 Oracle schema in the Food & Beverage Data Warehouse 

Run the Database Scripts 

After creating database instances, execute the appropriate scripts against the data warehouse. 

To create the XBRi Ingenium 10.8 Standard Tablespaces, Standard Security and database objects: 

1. Create the Standard table spaces by opening a SQL Query window either through Toad, SQL Plus 

or other client interface tool, and attach to the Food & Beverage data Warehouse database. 

2. Log into the new instance with the “sys” account and password as sysdba. 

3. Open the database script Oracle_standard_tablespaces.sql from: 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

The tablespace locations are set up by the Oracle DBA. You need to 
get the disk drive and directory where the Oracle data will be stored 
from the Oracle DBA. 

4. Ensure the table space locations are correct, then copy and paste the script into the SQL query 
window, and execute it.  

5. Open the database script Oracle_standard_security.sql  from 
CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

6. Copy the script into SQL Query window pointing to the Data Warehouse database. Ensure the 
database link create statement has the correct TNS name for the metadata database. Execute 
the script to create the database roles and users. 

7. Now run the Mymicros standard security script to give XBRI the read permissions to the 

underlying Mymicros data warehouse tables in the COREDB and LOCATION_ACTIVITY_DB 

schemas. Open the database script Oracle_Mymicros_security.sql from 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

8. Copy the script into SQL Query window pointing to the Data Warehouse database. Execute the 
script to grant access to the Mymicros data warehouse data. This script will need to be run from 
a user account with privileges. 

9. Execute  the pre new build database script: Open the database script 
pre_new_build_database.sql from 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 
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10. Now set up the public synonyms to the objects to which you just granted read permission. To do 
this, add two rows into the ADM_DATABASE_SETUP table, one row for each of the schemas you 
will be creating the synonyms against – COREDB and LOCATION_ACTIVITY_DB. 

Open the database script insert_adm_db_setup_MYMICROS_XBRi.sql from 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

and change the database and server name to the database and server you are installing on, 

leaving the DATABASE_TENANT and  DATABASE_LOCAL_REMOTE columns set to ‘M’ and ‘L’ 

respectively.  

For Food and Beverage installations, all databases will be treated as 
multi-tenant and local in the existing Mymicros database. There will no 
longer be a remote database option with database links for XBRi 10.8. 

11. Run the SP_PRO_DATABASE_SETUP procedure to define the synonyms on the Mymicros objects. 

12. Log out and log back in to the Mymicros data warehouse database as user XBRI. 
Open the database script build_database_mmxbr.sql from:

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

Copy the contents into the SQL Query window. Execute the script to create all the database 

objects tables, views, functions, stored procedures, triggers, and so on. If an error occurs while 

creating views, click ignore all, this is due to the synonyms not being created against the 

COREDB and LOCATION_ACTIVITY_DB objects yet, this will be completed after the metadata is 

loaded in the next step. 

To load the metadata: 

1. Load the XBRi 10.8 system table metadata. Open the metadata archive from: 

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL\METADATA

2. Unzip the core metadata to a new or empty folder. The contents of the core metadata archive 
are the common formatted .DAT files, the format .FMT files and two load command files, one 
for SQL Server and one for Oracle. We will use the Oracle Server version for this load  
core_xbri_metadata_load_oracle.cmd

3. Edit the command file core_xbri_metadata_load_mssql.cmd and set the database and file 
location variable to match the server and database you want to load. 

Example:

Set XBR_DATABASE=MMP3 

Set FILE_LOCATION=D:\Metadata \XBRiFS 

Set DATA_FILE_LOCATION=D:\Metadata\XBRiFS 

Set USER=XBRI 
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Set PW=Xbri$Adm1n 

4. Execute the command file by either clicking the file, or opening a command window and setting 
the default to the FILE_LOCATION folder. This loads the metadata. There will be a log file for the 
deletion of rows from the target table tablename_DELETE.LOG and a log file for the load of the 
target table tablename_LOAD.LOG. At the end of the load, all the individual load log files are 
concatenated together, so one log can be quickly scanned to see if there were any errors: 
databasename_LOAD_FULL.LOG

5. Execute the post new build cleanup script to set the IServer Database Type to Oracle as well as 
any other oracle specific modifications.

Open the database script post_new_build_core_data_fix.sql from:

CD:\DATABASE_SCRIPTS\ORACLE\NEW_INSTALL 

Copy contents into SQL Query window connected as XBRI and execute the script. 

Post Database Installation Setup 

Setting Start Time in the External Scheduler Table 

The next step is to set the External Scheduler kick off time by passing the hour and minute as 

parameters to the SP_LP_SCHEDULE_SET_TIME procedure. The following procedure uses the start time: 

11:45 pm. 

To execute the SP_LP_SCHEDULE_SET_TIME procedure: 

In the Query window, enter the following: 

DECLARE  

  PN_HOUR NUMBER; 

  PN_MINUTE NUMBER; 

BEGIN  

  PN_HOUR := 23; 

  PN_MINUTE := 45; 

  XBRADMIN.SP_LP_SCHEDULE_SET_TIME ( PN_HOUR, PN_MINUTE ); 

  COMMIT;  

END; 

Master Fiscal and Calendar Date tables 

The last step of the new database installation is to determine the Fiscal Date Calendar format and date 

range to create for the master date tables. If the customer is a retail customer following the standard 
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NRF Fiscal Calendar 4-5-4 monthly format, you don’t need to execute this step; the default fiscal 

calendar that was loaded with the core metadata has already been generated back seven years from the 

present to a fiscal year range of 2005 to 2030. 

If the customer needs a different date range or uses the fiscal 4-4-5 format, you must follow the next 

procedure to regenerate the data in the master date tables. The parameters in the example below will 

generate the date tables from fiscal 2006 to 2014 with weeks starting on Sunday. 

To regenerate the date tables with a different date range than the fiscal 4-5-4 format:  

Change the parameters as needed. 

In the Query window, enter the following: 

Example: 

BEGIN  

  XBRI.SP_MST_UPD_DATE_454 (1,'29-JAN-2006',2006,2014,7); 

  COMMIT;  

END;  

/ 

• The first parameter is the organization ID of the customer 

• The second parameter is the date for the first day of the Fiscal Year according to NRF 
standard 4-5-4 calendar. Years supported are from 2000 to 2031. A 4-5-4 fiscal calendar 
cannot be generated using an invalid fiscal year start date. 

• The third parameter is the fiscal year to start the calendar 

• The fourth parameter is the fiscal year to end the calendar 

• The fifth parameter is the day of the week that starts the fiscal week. The default for the 
U.S. is Sunday, day seven, with Monday being day one. 

If the company supports the non-NRF standard 4-4-5 fiscal calendar, then all the same parameters apply 

to the 4-4-5 procedure, you just need to change “_4-5-4” to “_4-4-5” 

In the Query window, enter the following: 

Example: 

BEGIN  

  XBRI.SP_MST_UPD_DATE_445 (1234'29-JAN-2006',2006,2014,7); 

  COMMIT;  

END;  
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/ 

Oracle Database Upgrade – 10.7 to 10.8 

Before you begin 

• Upgrade scripts are on the release CD in the following location: 
CD:\DATABASE_SCRIPTS\UPGRADE\ORACLE 

• Ensure your database is currently at XBRi version 10.7 GA, this database upgrade assumes all 
previous upgrades have been completed up through XBRi 10.7 GA 

Upgrade Oracle Database from XBRi 10.7 to XBRi 10.8 

1. Run the following scripts in the order shown, “appl” before “data.” 
xbr_appl_107_to_108_upgrade.sql 

xbr_data_107_to_108_upgrade.sql 

2. Copy/Paste each entire script into a SQL Query window and execute.  
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SQL Database Upgrade – 10.7 to 10.8 

Before you begin 

• Upgrade scripts are on the release CD in the following location: 

CD: \DATABASE_SCRIPTS\UPGRADE\MSSQL 

• Ensure your database is currently at XBRi version 10.7 GA, this database upgrade assumes all 
previous upgrades have been completed up through XBRi 10.7 GA 

Upgrade SQL Server Database from XBRi 10.7 to XBRi 10.8 

1. Run the following scripts in the order shown, “appl” before “data.” 
xbr_appl_107_to_108_upgrade.sql 

xbr_data_107_to_108_upgrade.sql 

2. Copy/Paste each entire script into a SQL Query window and execute.  
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Part 2 I-Server Installation 

If Case management configuration is performed during a new installation it 
should be selected along with web server and XBRi admin tools. The Case 
Management Configuration option should not be run "stand alone" subsequent to 
the XBRi installation. 

The first part of the XBRi Install program installs the I-Server- which is the middleman between the 

previously installed database and the application web server. You will install the web server after the I-

Server.  

For performance reasons, Oracle Micros recommends installing the I-Server on a separate machine. 

Prerequisites 
Before you begin, have the following information available: 

• MicroStrategy License Key.  

• A worksheet with the values to enter at the installation prompts. Most of these pertain to the 

servers at the client site and must be obtained from the customer. 

• The XBRi installation DVD from Oracle Micros  

If you are installing directly from ISO, we recommend using software 
like Magic DiscTM that automounts upon server reboot. 

To run the I-Server Installation program: 

1. Open the installation DVD on the I-Server where you will be doing the installation. 

2. Double click on setup.exe. 

3. Click Yes on the Windows User Account Control dialog. 
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This displays the following screen: 

Click Next.
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Select the check box next to IServer Components and click Next. 

If you are installing IServer and Web & XBRi Components on same 
server, also select the Web & XBRi Components check box. It is not 
possible to complete the IServer installation and subsequently run 
setup to install Administration and Web on the same server. The 
instructions in this guide pertain to installation on two servers, which 
is the recommended configuration. 

.
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Select the type of installation: Food & Beverage or Retail & Grocery from the drop-down box. 

Verify that the home directory is set correctly. This directory must exist. The XBRi folder will be created 

here. Click Next. 
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Enter the required information at the prompts: 

Check the path for the directory where files will be copied and change if necessary. 

Check the path for the directory where common files will be copied and change if necessary. 

Enter the name of the registered company. The customer can provide this information. 

Enter the Name of the registered user. This is the User Name of the XBRi Administrator.  

Enter the MicroStrategy License key number. 

When you are done, click Next. 
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Enter the settings for the Data warehouse Database.  Database connection information that you enter 

will be carried forward to each of the three subsequent database settings pages. 

The Database Administrator at the customer site can provide these values: 

DW dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

DW dbserver – Enter the data warehouse database server name.  

DW dbport – Enter the data warehouse database port number. 

DW dbname – Enter the data warehouse database name 

DW dbuser – Enter the datawarehouse database user name. 

DW dbpass - Enter the db password in both boxes. This will be encrypted and saved during XBRi

configuration. 

When you are done, click Next. 



XBRi 10.8.1 Installation Guide 

29 

Enter the settings for the Metadata Database. The Database Administrator at the customer site can 

provide these values: 

MD dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

MD dbserver – Enter the metadata database server name.  

If MSSQL DW DB Instance – Enter the database instance if the database server is SQL. 

MD dbport – Enter the metadata database port number. 

MD dbname – Enter the metadata database name. 

MD dbuser – This displays the registered user name that was previously entered. 

MD dbpass - This displays the password that was previously entered. This will be used when the 

metadata tables are created. 

When you are done, click Next. 
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Enter the settings for the History List Database. The Database Administrator at the customer site can 

provide these values: 

HL dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

HL dbserver – Enter the history list database server name.  

HL dbport – Enter the history list database port number. 

HL dbname – Enter the history list database name. 

HL dbuser – This displays the registered user name that was previously entered. 

HL dbpass - This displays the password that was previously entered. This will be used when the 

metadata tables are created.  

When you are done, click Next. 
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Enter the settings for the Statistics Database. The Database Administrator at the customer site can 

provide these values: 

ST dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

ST dbserver – Enter the statistics database server name.  

ST dbport – Enter the statistics database port number. 

ST dbname – Enter the statistics database name. 

ST dbuser – This displays the registered user name that was previously entered. 

ST dbpass - This displays the password that was previously entered. This will be used when the 

metadata tables are created. 

When you are done, click Next. 
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Enter the settings for the I-server.  

Server Name – Enter the I-Server name. This can be provided by the Database Administrator or 

IT support at the customer site. 

Project Source – Enter a descriptive name for the XBRi  project source, e.g., XBRi. 

Project - Enter a descriptive name for the XBRi  project, e.g., DW_RG_DEV. 

When you are done, click Next. 
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Enter the settings for the I-server service account.  

In order for file and print subscriptions to function correctly the IServer service should run using a 

domain account that has access to the printers and directories that will be used for report distribution.  

If a named account is used the credentials will be validated before the installation continues. 

Domain – Enter the Domain of the service account.  If local account, leave this box blank. 

Login – The user account that will be used to run the IServer service. 

Password – The password will be saved when creating the Windows service. If it is an expiring 

password it will require updating the windows service each time the password is changed. Enter 

it in both boxes. 

If file and print subscriptions will not be used you may opt to use the local system account. 

When you are done, click Next. 
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Click Next. 
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The installation progress status is displayed. 
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Click Finish. This displays the following prompt: 

Click Yes to finish the installation and restart the computer. 
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1. When your computer restarts, the install program will launch, and you will see the following 

screen: 

(This dialog may take some time to appear.) 

2. Click Yes on the Windows User Account Control dialog. 

The installation will then begin using the answers you provided previously.  

The install program will launch the MicroStrategy installation, which may take some time. 
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When the MicroStrategy installer has finished, you will see the following message: 
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After the MicroStrategy installation completes, you must reboot. 

Click OK, then manually restart the server.  

When the server comes back up, the installation will resume. 

It may take a several minutes for the Windows User Account Control dialog to appear. When it does, 

click Yes. 

This step will create ODBC DSNs, MicroStrategy metadata tables, and the server definition for the 

IServer. You will see the following progress indicators as each action is executed:  
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Click Next. 

This completes the IServer Installation. It is recommended to reboot the server at this point. 

The next step is to install the Web Server, optimally on its own physical or virtual machine. 
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Part 3 Web Server Installation 

If Case management configuration is performed during a new installation it 
should be selected along with web server and XBRi admin tools. The Case 
Management Configuration option should not be run "stand alone" subsequent to 
the XBRi installation. 

The second part of the XBRi Install program installs the Web Server, which hosts the XBRi application.  

There are three steps to the Web Server Installation: 

1. Running the XBRi Install Data Gather and Setup XBR Install programs 

2. Removing MicroStrategy objects 

3. Running the XBRi Install Program 

For performance reasons, Oracle recommends installing the Web Server on a separate machine, which 

can be either physical or virtual. 

Prerequisites 
Before you begin, have the following information available: 

• MicroStrategy License Key.  

• A worksheet with the values to enter at the installation prompts. Most of these pertain to the 

servers at the client site and must be obtained from the customer. 

• The XBRi installation DVD from Oracle 

Step 1 – Running the XBRi Install Data Gather and 

Setup XBR Install programs 

To run the XBRi Install Data Gather and Setup XBR Install programs: 

1. From the installation DVD on the I-Server where you will be doing the installation. 

2. Double click on setup.exe. 

3. Click Yes on the Windows User Account Control dialog. 
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This displays the following screen: 

Click Next, and follow the rest of the prompts in the installation program: 
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Select the check box next to Web and XBRi Components.  

If also setting up Case Management integration select the Case Management Configuration check box. 

This option must be selected and installed concurrently with the Web and XBRi Components .  

When desired components are selected, click Next. 
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Verify that the home directory is OK, and click Next. 
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Enter the required information at the prompts: 

Check the path for the directory where files will be copied and change if necessary. 

Check the path for the directory where common files will be copied and change if necessary. 

Enter the name of the registered company. The customer can provide this information. 

Enter the Name of the registered user. This is the User Name of the XBRi Administrator.  

Enter the MicroStrategy License key number. 

When you are done, click Next. 
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Enter the settings for the Datawarehouse Database. The Database Administrator at the customer site 

can provide these values: 

DW dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

DW dbserver – Enter the data warehouse database server name.  

DW dbport – Enter the data warehouse database port number. 

DW dbname – Enter the data warehouse database name 

DW dbuser – Enter the datawarehouse database user name.  

DW dbpass - Enter the db password in both boxes. This will be encrypted and saved during XBRi 

configuration. 

When you are done, click Next. 
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Enter the settings for the Metadata Database. The Database Administrator at the customer site can 

provide these values: 

MD dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

MD dbserver – Enter the metadata database server name.  

If MSSQL DW DB Instance – Enter the database instance if the database server is SQL. 

MD dbport – Enter the metadata database port number. 

MD dbname – Enter the metadata database name. 

MD DB user – This displays the registered user name that was previously entered. 

MD DB PW - This displays the password that was previously entered. This will be used when the 

metadata tables are created.  

When you are done, click Next. 
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Enter the settings for the History List Database. The Database Administrator at the customer site can 

provide these values: 

HL DB dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

HL DB server – Enter the history list database server name.  

HL DB port – Enter the history list database port number. 

HL DB name – Enter the history list database name. 

HL DB dbuser – This displays the registered user name that was previously entered. 

HL DB pass - This displays the password that was previously entered. This will be used when the 

metadata tables are created. 

When you are done, click Next. 
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Enter the settings for the Statistics Database. The Database Administrator at the customer site can 

provide these values: 

ST DB type – Select the type of database server from the drop-down list, Oracle or SQL. 

ST DB server – Enter the statistics database server name.  

ST DB port – Enter the statistics database port number. 

ST DB dbname – Enter the statistics database name. 

ST DB user – This displays the registered user name that was previously entered. 

ST DB pass - This displays the password that was previously entered. This will be used when the 

metadata tables are created. 

When you are done, click Next. 
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Enter the settings for the I-server.  

Server Name – Enter the I-Server name. This is the same name specified in the I-Server 

installation. 

Project Source – Enter a descriptive name for the XBRi  project source, e.g., XBRi. 

Project - Enter a descriptive name for the XBRi project, e.g., CORE_XBRi_10. 

When you are done, click Next. 
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Enter the customer’s Organizational Settings: 

Webserver Name – Enter the Web Server name. This is the name of the server where you are 

currently doing the install. 

OrgID – The customer’s Organization ID. This is usually 1 for Retail & Grocery and will be the 

actual OrganizationID value from Mymicros for Food & Beverage. 

Org Code – The code assigned to the customer by Oracle. 

Customer Name – The name of the customer organization. 

Start Time – Enter the start time for schedules in the format: 00:00 – 23:59. This should be at 

least 15 minutes after the expected ETL completion. If the hour is less than 10, you must include 

a leading zero (09:00). 

When you are done, click Next. 
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Optional - Enter the Case Management Configuration Settings: 

Enter the fully qualified URL to access Case Management online. example: 

https://appserver1.lpguys.net/microstesting/lpms

Enter the fully qualified URL to access Case Management Web Services endpoint. example: 

https://appserver1.lpguys.net/microstesting/lpms/webservice/dataservice.asmx

Enter the user name to access the Case Management System.  

Enter the password to access the Case Management System.  

When you are done, click Next. 
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Click Next. 
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The installation progress status is displayed. 
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Click Finish. This displays the following prompt: 

Click Yes to finish the installation of XBRi Data Gather and restart the computer. 
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1. When the computer restarts, the install program will launch, and the following dialog will 

appear: 

2. Click Yes on the Windows User Account Control dialog. 

The installation will then begin using the answers provided previously. This step will install Java, and the 

MicroStrategy tools.  The following progress indicators will be displayed: 

The install program will launch the MicroStrategy installation which may take some time. 
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When the MicroStrategy installer has finished, the following messages will be displayed:

After the MicroStrategy installation completes, a reboot is required. 
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Click OK, and then manually restart the server.  

When the server comes back up, log in again and the installation will resume.  

There will be a long pause and the screen may be blank while the MicroStrategy installation is 

continuing. Do not do anything until this phase completes. 

When the Windows User Account Control dialog appears click Yes. This step will create ODBC DSNs, 

configure the IServer, and create a project source for the IServer. 
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When the step has completed, the following dialog is displayed: 

The XBRi install icon is now present on the desktop: 

Do not run the XBRi Install program until you have performed Step 2, 

Removing the MicroStrategy Objects. 

Step 2 – Manual Edit of User and Group Objects 
Click the Windows Start menu and choose All Programs -> MicroStrategy -> Desktop from the program 

list. 

When MicroStrategy Desktop starts, a Login prompt may be displayed. If so, click Cancel.

Right click on the XBR Project Source and click Connect to Project Source. The Login prompt will be 

displayed. 



XBRi 10.8.1 Installation Guide 

60 

Enter Administrator in the Login id field and leave the password blank.  Click OK. 

The following informational message is displayed. Click OK. 

Expand the XBRi folder and the Administration folder. 
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1. In the Administration folder, right click on User Manager and choose Properties from the 

context menu. 

2. Select Security . 

3. In the Properties: Security window, delete all ACL entries as shown below.  

4. Click OK to accept changes.  

5. Click Yes to save the changes. 
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Right-click the Everyone group under User Manager, and select Properties, then click Security. 

Delete all ACLs entries from the Everyone group. 

After Deletion 
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Repeat the process for the Administrator user which will be found within the Everyone group. 

Delete all ACLs entries from the Administrator user. 

After deletion 

Right click on the XBRi project source and click Disconnect… Then close MicroStrategy Desktop.
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Step 3 – Running the XBRi Install Program 

Double click the XBRi Install icon  to launch the XBRi Install program. 

This step includes: 

• duplication of the CORE XBRi project to the customer project source 

• application of object manager configuration packages 

• execution of command manger scripts 

• running database org intro and cloning procedures 

• installation of webserver including creation of windows service 

• installation of external scheduler including creation of windows service 

• installation of date selection batch process and creation of windows scheduled task 

The project duplication step may take over 20 minutes to complete. 

As each action is performed several progress indicators will be displayed, including the following: 

This completes the automated portion of the install.  
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Part 4 Manual Configuration Steps 
After installing the database server, Iserver and web server, you must perform these manual steps to 

complete the installation. 

Step 1: Configure the XBRi Project (After 

Duplication) 
1. Log in to MicroStrategy Desktop. Since the core project has been duplicated the Administrator 

account is now password protected, which is now CoreAdmin12!

2. Click on XBRi (project Source) and expand the Administration folder.  

3. From the Administration folder, right click on User Manager and choose Properties from the 

context menu.  

4. In the Properties: Security window, set the Access Control List (ACL) as in the screenshot below:  

5. Click the OK button. 

Remove Everyone Group from Normal Users security role (if exists) 

1. Navigate to Administration\Configuration managers\Security Roles. 

2. Right-click Normal Users security role and select Edit.

3. Click on Members tab and remove Everyone from Selected members list so there are no 

members as in the screenshot below. 
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4. Click OK
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Step 2: Configure the SMTP Server   

If the customer site uses a smart host email server, configure as in 
the following screenshot. Otherwise, leave the IP Address/Server 
Name box blank and do not check Always use Smart Host. 

1. Log in to MicroStrategy Desktop. 

2. Click on XBRi (project Source) and click on Administration.

3. Navigate to Delivery Managers > Devices > Generic email. 

4. Enter the correct E-Mail Server settings. 



XBRi 10.8.1 Installation Guide 

68 

Step 3: Configure I-Server Settings: 

1. Log in to MicroStrategy Desktop. 

2. Right click on XBRi (project Source) and click on Configure Intelligence Server.
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3. Specify the content server location. This is the database connection that will be used for the 

History List. Right click on project source and choose configure Intelligence Server.  On the 

Server definition  General page, configure the settings as they are displayed in the screenshot 

below. 
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4. On  the Server definition > Security page, configure the settings as they are displayed in the 

screenshot below: 

5. Navigate to the Governing rules > Default > General  page. 

6. Select the check box below: 

7. Navigate to the Governing rules > Default > File Generation page. 

8. Under HTML Generation,  set the Maximum memory consumption for HTML files [MB] for the  

customer.  (Small/medium/Large) = (100/512/1024) 

9. Click OK to accept the changes. 
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10. Click OK in the message box: 
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Step 4:Configure Project Configuration Settings 

To configure the project: 

1. Log in to MicroStrategy Desktop if not already logged in. 

2. In the XBRi project Source right click on the project name and select Project Configuration.

3. In the Project Definition - History List page, clear the check box for Save Report Service 

Document dataset messages to history list.

4. Navigate to the Governing rules > Result Sets page. 

Set Wait time for Prompt answer (sec) to 3600 

Set Warehouse execution time (sec) to 3600. 

Set Memory Consumption during SQL generation (MB) to -1. 
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5. Navigate to the Governing Rules > Default > Jobs page and use these guidelines to enter 

the following settings: 

Jobs per user account – Set to 50 

Jobs per session – Set to 50 

Executing jobs per user – Set to 10 

Jobs per project – Limits the number of concurrent jobs that may exist on the I server, 

Recommended settings are:  Small – 1000, Medium – 5000, Large - 50000 

Interactive jobs per project - Set to -1 

Scheduled jobs per project – Set to -1 

6. Navigate to the Governing Rules > Default > Import Data page and use these guidelines 

to enter the following settings: 

Maximum File Size – Set to 50 

Maximum Quota Per User– Set to 500 
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7. Navigate to the Caching >Result Caches> Creation page and clear the Enable report 

server caching check box. 

8. Navigate to the Caching >Result Caches> Storage page. 

Set Cache file directory to .\Caches 

Under Datasets:

Set Maximum Ram usage (Mbytes) to 100/512/2048 (small/medium/large) 

Set “Maximum number of caches to -1 

Under Formatted Documents:  

Set Maximum RAM usage (Mbytes) to one of these values:  100/250/500 

(small/medium/large) 

Set Maximum number of caches to -1 

Clear the Load caches on startup check box. 

9. Click OK, and then click OK in the message that is displayed: 



XBRi 10.8.1 Installation Guide 

76 

This returns you to the Caching – Result Caches – Storage window. 
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10. Navigate to the Caching >Result Caches > Maintenance page, and select the Never 

expire caches check box. 
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11. Navigate to the Caching >Auxiliary Caches>Objects page 

Under Server:  Set Maximum RAM Usage (Mbytes) to 500 

Under Client:  Set Maximum RAM Usage (Mbytes) to 500 
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12. Navigate to the Caching > Auxiliary Caches > Elements page 

Under Server:  Set Maximum RAM Usage (Mbytes) to 500 

Under Client:  Set Maximum RAM Usage (Mbytes) to 500 
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Navigate to the Intelligent Cubes > General page. 

Set Maximum % growth of an Intelligent Cube due to indexes to 50 

Set Cube growth check frequency (in mins) to 240 

Clear the Load Intelligent Cubes on startup check box. 

To update the web URL: 

1. Log in to MicroStrategy Desktop. 

2. Right click on XBRi (project Source) and click on Project Configuration.

3. Navigate to Project definition  > Documents and Reports . 
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4. In the two fields under Web Server, enter the URL of the Web Server. 

Example:  

http://WEBSERVER/analytics/servlet/mstrWeb 

or for SSL 

https://WEBSERVER/analytics/servlet/mstrWeb 

Oracle installations Only 

5. Note: this step is for Oracle users only.  Click on the Database Instances folder and select SQL 

Data Warehouses. 

Configure Database Instance  

If you are doing an installation for a customer with an Oracle database, you must change the database 

instance in MicroStrategy Desktop for SQL to point to Oracle. This is a workaround that corrects a 

current problem with using the Oracle database instance. 

To change the SQL Database Instance to Oracle: 

1. Log into the Desktop. 

2. Navigate to Administration > Configuration Managers > Database Instances. 

3. Select the CORE_DW_EMGR_S database instance.  

https://webserver/analytics/servlet/mstrWeb
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4. Double click on it, or right click and choose Edit from the context menu. 

Either action displays the Database Instances editor. 

5. From the Database connection type drop-down menu, select Oracle 11gR2. 

6. In the Database connection (default) list, select APP_ST_O.
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7. Click the Modify button. This displays the Database Connections dialog. 

8. Verify that APP_ST_O is selected, and click OK. 

9. Click OK in the Comments dialog. 

10. Click OK and exit the dialog box. 

The images below show the default configuration: 
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1. (Oracle users only) Highlight the instance CORE_DW_RG_O for Retail installations, 

or  CORE_DW_FB_O for Food & Beverage installations, and click the Set as Default button. Click 

OK.

2. Click OK in the message that is displayed: 
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Step 5: Configure the Enterprise Manager  

1. Navigate to the Project Configuration > Database Instances > Statistics page,  and select the 

DSN created for the Statistics database : 

This value should always be CORE_DW_EMGR_S. 

2. Navigate to the Statistics > General page and select the options  as in the screenshot that 

follows: 
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3. Click OK. This configures the Statistics database. 

4. From the Start menu, expand the MicroStrategy > Tools folder and click Enterprise Manager 

Console. 

5. Click Yes in the Enterprise Manager message. 
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This displays the Enterprise Manager Console. 

In the Enterprise Manager Console: 
1. Click 1. Initialize then Next to Initialize the project. This displays the 1.2 Initialize Project 

window. 

2. Click the Transfer button.  This transfers the statistics database tables. 
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This initiates the Project Mover Wizard.   

Verify that the locations of the Metadata Repository Source \ and Warehouse Source are correct, and 

click Next. 
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Make sure the correct project is selected and click Next.
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Click the browse icon. This displays the list of sql assoicated with different dabases.  

Select the appropriate sql and click Open. 
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For Sql : select  em_sql  or em_sql_2005_2008. (depends on type of database). 

For Oracle : Select em_sql_ora.sql. 

             Click Next. 
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Select the Data Source Name of the Statistics database and provide User Name and Password for the 

statistics database for the Metadata Repository. Click Next. Do the same for the Warehouse Location. 
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Verify that the Create Project Source check box is selected and that the project source is correct. 

Click Next.       
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Verify the details you have provided and click on Transfer. 

This initiates loading the statistics table into the database. 

Wait until the transfer is complete and click Next. 
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Click 2.2 Choose Projects.

Configure the server project source and project and click Next. You will need to supply the current 

Administrator user and password CoreAdmin12! 
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Define the schedule for loading data. The schedule can be automated or manual.  
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Step 6: Refresh Cubes 

1. Log into the Desktop. 

2. From the menu choose Tools > Desktop Preferences and navigate to Desktop > Browsing

3. Select the Display hidden objects checkbox as shown below. Click OK. 

4. Expand the project folder. 

5. Navigate to Public Objects > Reports > Cubes. 

6. Double click on each cube to run it and refresh the Intelligence Cube caches 
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Scheduling daily refresh 

To refresh the Intelligence Cubes on a daily basis, set up a Windows Task Scheduler job to run a batch 

command file, i.e.   cube_update.bat with command to launch command manager from the command 

line and run a command manager script, i.e. cube_update.scp with commands to publish each cube 

cube_update.bat 

cmdmgr.exe" -n XBRi -u Administrator -p CoreAdmin12! -f C:\XBRi\cube_update.scp -or 

C:\XBRi\cube_update_results.log -of C:\XBRi\cube_update_fail.log -os 

C:\XBRi\cube_update_success.log –e 

cube_update.scp 

PUBLISH INTELLIGENT CUBE "Field Dashboard - iCube" IN FOLDER "\Public 

Objects\Reports\Cubes" FOR PROJECT "XBRi"; 

... 



XBRi 10.8.1 Installation Guide 

99 

Step 7: Update Database instance for Transaction 

Reports 

This procedure is for Oracle installations only 

Follow this procedure for all of the Transaction reports in a folder. 

Right click on the Transaction report and choose Edit. 

This opens the Transaction report. Click the Freeform SQL Definition button. 
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This displays the Freeform SQL window. From the Database Instance drop-down list, select the 

appropriate database instance. 

Click OK and Save and Close. 
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Repeat these steps for every Transaction report in the folder. 
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Step 8:  Create Trusted Authentication. 

Start the Apache Tomcat XBRi Webserver service and launch the XBRi URL 

(http://WEBSERVERNAME/analytics/servlet/mstrWebAdmin).   If this is the first time the Webserver is 

started, there will be a delay while the war file is un-archived. Log in with the webadmin user and 

password w3b@dm1n.  

Set up trusted authentication 

Under Web Server, navigate to Intelligence Servers > Server. 

Enter the I-Server Name, and click Add. This adds the I-Server to the list under Web Server. 
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Click on the I-Server name and configure the Connection Properties if required. 

Click Connect. 

The I-Server is displayed under Connected Servers. Click the properties icon to the right of the page. 
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Click on the Setup button in the Server Properties panel. 
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Set up the Trust Relationship 

Select the Standard (user name and password) option. 

Enter the MicroStrategy Administrator User Name and Password. 

Enter the URL of the Web Server Application. 

Click Create Trust Relationship. 
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Verify that the Connection properties are OK and click Save. 

Step 9: Set the Default Start Page to the Home 

Page 
Click the MicroStrategy Web Home link 

1. Log in as the Core XBRi Administrator user for the project. 

2. From the Admin menu, choose Project Defaults. 

3. Set the Default start page to Home. 

4. Apply or Save the change and log out. 
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Step 10: Set up File and Print Subscriptions 

This step should not be done for hosted customers and customers not 
using file and print subscriptions. 

Configure Printer and Install Adobe Acrobat Reader®

This step is required for print subscriptions to work correctly. 

Notes: 

• The Intelligence Server must be running as a service. 

• The Windows NT account running the Intelligence Server must have correct privileges or 
permissions to access printers on the network or local Intelligence Server machine. 

• The latest version of Adobe Acrobat® or Adobe Acrobat Reader® must be installed on the 
Intelligence Server 9.x machine for Print subscriptions to print correctly. 

• If Adobe Acrobat® or Adobe Acrobat Reader® has been installed, Print subscriptions will not 
work correctly until the Adobe License Agreement has been accepted. The license must be 
accepted while logged in with the Windows NT account running Intelligence Server. 

1. In Windows Services, stop the MicroStrategy Intelligence Server service. 
2. Set the MicroStrategy Intelligence Server service to run with a domain ID, not the local system. 
3. In Windows Services, restart the MicroStrategy Intelligence Server service. 
4. Go to the Adobe website 

http://www.adobe.com/support/downloads/detail.jsp?ftpID=5336%20 and download the latest 
version of Adobe Acrobat Reader®. 

5. Start Adobe Acrobat Reader®  installation and accept the license agreement.  
6. After Acrobat Reader®  is installed, add a printer as a local printer. 
7. Share the printer. 
8. Open Desktop. 
9. Create a new device type, Print. Enter a name and description for it. 
10. For the Print Location, enter the name of the local printer added in step 6. 
11. On the PDF tab in the Application Priority section, select Intelligence Server. 
12. On the Advanced tab, under Backup Delivery Options, select the Save to Backup Location check 

box. 
13. Select the Save Files to Location radio button and enter the name of a writeable directory on the 

server. 
14. In the Governing section, enter as the File Location the name of a writeable directory on the 

server. 
15. Set the Retry and Timeout settings to practical values such as 5 retries and 10 minute timeout. 
16. Modify ACL settings to give Everyone View privileges on the printed output in the specified 

directories.  Remove all other ACL entries except Administrator. 

http://www.adobe.com/support/downloads/detail.jsp?ftpID=5336%20
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For more information, see MicroStrategy Technical Note 3075, which provides detailed steps for setting 
up a printer for distribution services. 
https://resource.microstrategy.com/support/Authoring/DisplayTN.aspx?tnkey=30756&formatted=1

Step 11: Create First Customer Administrator 

After XBRi is installed, you need to create a new Customer Administrator account. After you set up the 
account, an email is mailed to the Customer Administrator with a temporary password with which to log 
into the application.  

To create the customer administrator: 

1. Go to the Analytics website at http://WEBSERVERURL/analytics. 
2. Log into XBRi using the following credentials: 

Org code – customer's org code / three letter user name prefix  (Food & Beverage install only) 
User name – the user name of the  XBRi administrator 
Password – default password 

3. From the Admin menu, choose User Manager. 
4. Click on the Administrator group. Important! - go to the lowest Administrator group level if 

there is more than one. 

5. Click the Create New User  icon. This displays the User Editor. 
6. On the General tab, enter the following:  

Login name – The name the customer administrator will use when logging into the XBRi. 
Full name – A description of the user. 
Set User Type – Choose Administrator from the drop-down list. 

7. On the Addresses tab, under E-mail Addresses, click Add a new address, and enter the 
following: 
Address Name – the customer administrator’s e-mail name. 
Physical Address – add the customer administrator’s email address. 

8. Under Actions, click Save. 
9. On the Feature Security tab, select the check boxes next to the Features that the customer 

wants enabled. 
10. Click OK when done.  

An email is sent to the user with a temporary login password. During their first login, they will be 
prompted to specify security questions and answers. 

https://resource.microstrategy.com/support/Authoring/DisplayTN.aspx?tnkey=30756&formatted=1
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Step 12: Customer Administrator Creates New 

Users and Groups 

The Customer Administrator must create an account for each XBRi user to enable them to log into the 

application and to grant them access to the features and privileges appropriate to their role. When the 

user is created, they are added by default to the Everybody group and to the User Type group that the 

administrator selects when creating the user. Oracle Retail provides the Everybody group and the User 

Type groups, which cannot be modified. The Customer Administrator can create additional customizable 

groups and add users to them. 

To create a user: 

1. Log in to XBRi as the Customer Administrator. 

2. From the Admin menu, choose User Manager. This displays the User Manager, which lists the 

user groups. 

3. Click the New User icon    on the toolbar. This displays the User Editor. 

4. On the General tab, enter the following information: 

• Login name and Full name of the new user, and a Description. Note: The login ID is 
limited to 50 characters 

• Set the Password expiration frequency.  

• Select a User Type from the drop-down list. This determines the privileges the user will 
have, for example on reports, documents and features. 

• Make sure the Account disabled check box is cleared. 
5. On the Security Filters tab, assign a security filter to the user. These restrict the data the user 

can see displayed in reports. In many cases you will need to create a new security filter for the 
user.  (This step is optional). 

6. On the Groups tab, select the group(s) to which you want to assign this user. The user inherits 
any features that are enabled for the group, and inherits any security filter restrictions from 
security filters assigned to the group to which he or she belongs. The user is automatically 
assigned to the group associated with the selected user type as well as the Everybody group. 
(This step is optional). 

7. On the Addresses tab, add e-mail, file, or printer addresses. At least one e-mail address is 
required. These are used for report and document delivery if the user is subscribed to it.  

8. On the Contacts tab, grant the user access to specific shared contacts and contact groups. 
Contacts can be used when scheduling report or document deliveries for recipients who are not 
application users. Note: Shared contacts and contact groups can be only created by Oracle. 

9. On the Feature Security tab, select all of the features you want to assign to the user by selecting 
the check boxes in the User Level column. 

Only use a Customer Administrator account to create new users and 
groups. 
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10. Click OK to save the new user and return to the User Manager. 

After you save the new user, they are sent an email with a temporary password that they can use to log 
in for the first time. 

To create a group: 

1. Log in to XBRi as the Customer Administrator. 

2. From the Admin menu, choose User Manager. This displays the User Manager, which lists the 

user groups 

3. Click the New Group icon    on the toolbar. This displays the Group Editor. 

4. On the General tab, enter a name and description for the group. 

5. On the Security Filters tab, assign security filters. These restrict the data this group can see 

displayed in reports. (This step is optional). 

6. On the Groups tab, you can place existing groups within the new group you are creating. Any 

groups that you select from the list are placed within the new group, and therefore, at a lower 

level than your new group. You can expand and contract the existing groups to locate specific 

users, or search for groups using the Search field. 

7. On the Members tab, you can determine which users will belong to your new group. You can 

expand and contract the existing groups to locate specific users, or search for users using the 

Search field. 

8. On the Feature Security tab, select the check box next to each feature you want to enable for 

the group. 

9. Click OK to save the new group and return to the User Manager. 
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Step 13: Add ORG ID to Cubes (F&B only) 

For Food and Beverage customers, post installation, you will need to make sure that for all cubes in a 

project, the correct Organization  ID appears in the report filter. 

To add the ORG ID to cubes: 

1. Log into Desktop. 

2. Navigate to the <project_name>\Public Objects\Reports\Cubes folder. 

3. For each cube in the folder, right click on the cube and choose Edit from the context menu. 

4. In the Inteligent Cube Editor, double click on Organization (ID) Exactly <ORG ID>

5. In the Attribute Qualification panel, enter the correct ORG ID in the Value field. 

6. Click OK. 

7. Click Save and Close. 

8. Continue until you have entered the correct ORG ID number in the report filter for each cube. 

9. After you have finished, republish all of the cubes you have edited. 
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Step 14: Disable MFD Task and Remove Batch File 
After installation you must disable the scheduled MFD task in Windows Task Scheduler and remove the 

MFD batch file from the XBRi application folder. 

Note: This step will not be necessary in the next  installation program that corrects this problem. 

To disable the Master File Distribution process: 

1. From the Web server, open the Task Scheduler. 

2. Navigate to the Task Scheduler library. 

3. Locate the Master File Distribution Process on the tasks list and right click on it. 

4. From the context menu, choose Disable. 

To remove the mfdBatch file: 

1. On the Web server, navigate to the XBRi\batchProcessMFD folder. 
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2. Locate the mfdBatch file and right click on it. 

3. From the context menu, choose Disable. 
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Step 15: Configure for Master File Distribution 

The Master File Distribution feature allows customers to send subscription reports to recipients who are 

not defined users in XBRi. This is done through Dynamic address lists that are derived from reports 

based on the core master tables for Store, District, and Region for Retail installations and District and 

Location for Food and Beverage installations. When you create a dynamic address list, it becomes 

available on the Recipients list for creating email subscriptions. 

The reports used for creating dynamic address lists are stored in the Shared Reports > Master File 

Distribution folder. They include columns for Email, Device ID and Linked User ID. The Device ID column 

is initially populated when the application is installed or when new rows are added to the master files. 

The Linked User ID column is updated in the master files when you run the Master File Batch Update or 

through the application. See Step F: Populate the Master File tables.  

This section contains the steps form enabling master file distribution to using dynamic address lists: 

Step A: Enable Master File Distribution for the project

Step B: Give access to the correct users and groups

Step C: Verify that key columns and security filter key attributes are correct

Step D: Master File Distribution Reports

Step E: Create Dynamic Address Lists

Step F: Populate the Master File tables

Step G: Using Dynamic Address Lists in Subscriptions 

Step H: Device IDs in Master Files for Dynamic Address lists 

Step I: Change the MFD Key Mapping after the MFD Update has been Run 

Step J: Adding New Attributes 

Step A: Enable Master File Distribution for the project 

1. Log in to XBRi as the Core XBRi Administrator. 

2. From the Admin menu, choose Customization Manager. 

3. In the Feature list, select the check box next to Master File Distribution. 

4. Click Apply. 

By default, this feature will be On. 
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Step B: Give access to the MFD feature: 

In the XBRi User Manager, turn on the Master File Distribution feature for the administrator users: 

To give users and groups access to the Master File Distribution feature: 

1. Log in to XBRi as a customer Administrator. 

2. From the Admin menu, choose User Manager. This displays the User Manager. 

• If you want to give access at the group level, click the Edit icon  in the Group row. 

• If you want to give access at the user level, expand the group, and click the Edit icon  in 

the user row. 

3. This displays the Group Editor for a group or the User Editor for a user. 

4. Click the Feature Security tab. 

5. Select the check box next to Master File Distribution. 

6. Click OK. 

By default, this feature will be On. 

Step C: Verify that key columns and security filter key 

attributes are correct 

Several new attributes have been created specifically for Master File Distribution. For Retail, they are 

Store MFD, District MFD and Region MFD. For Food Service, they are District MFD and Location MFD. 

These attributes are used in the reports on which the dynamic address lists are based. See: Step D: 

Master File Distribution Reports. 

After XBRi is installed and MFD is enabled for the project, you need to review the Master File 

Distribution settings in Project Defaults and verify that the MFD mapping matches the key columns for 

each of the master tables. For example, if Store is not unique, Store and Division should be selected as 

keys. 

Also, each of the mappings have a security filter associated with it. The security filter ensures the data 

sent is only for that one store or one district, etc. These also need to be correct for the customer site. If 

not, you can change them using the editing icons in the Project Defaults Master File Distribution page.  
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To verify key columns are correct and modify if needed: 

1. Log in to XBRi as a customer Administrator. 

2. From the Admin menu, choose Project Defaults. 

3. Under Settings, choose Master File Distribution. 

4. For each table in the Browse List, select the table and click the Define key columns in database 

table  icon. 

Verify that the key columns are correct. If not, you can move a column from the Available to the 

Selected list. 

5. When you are done selecting the key columns, click OK. 

To verify key attributes in the security filter are correct and modify if needed: 

1. Log in to XBRi as a customer Administrator. 

2. From the Admin menu, choose Project Defaults. 

3. Under Settings, choose Master File Distribution. 

4. For each table in the Browse List, select the table and click the Define key attributes for Security 

Filter icon.  

Verify that the key attributes are correct. If not, you can move an attribute from the Available to 

the Selected list. 

5. When you are done selecting the key attributes, click OK. 

Step D: Master File Distribution Reports 

The reports used for creating dynamic address lists are stored in the Shared Reports > Master File 

Distribution folder. They each contain the MFD attributes that are derived from core master tables for 

Store, District, and Region for Retail installations and District and Location for Food and Beverage 

installations. They include columns for Email, Device ID and Linked User ID. The Device ID column is 
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populated when the application is installed or upgraded. The Linked User ID column is updated 

whenever you run the Master File update to populate the Master File tables.  

The dynamic address lists that you create in the next step use the addresses associated with the Linked 

User IDs from the Master File Distribution reports in the Shared Reports > Master File Distribution 

folder.  

Step E: Create Dynamic Address Lists 

The next step is to create Dynamic Address lists for the customer. You create a Dynamic Address list by 

linking it to one of the reports in the Shared Reports > Master File Distribution folder. The emails that 

will be sent are determined by the report to which it is linked. If you need to create a dynamic address 

list with a different MFD report, you will need to create or modify the existing MFD reports. For 

example, you can add a filter to the Store Master File Distribution report to filter for specific stores in 

the Western Region.  

The subscription processing cannot handle more than 2000 users at 
one time. If the master file list of recipient users exceeds or comes 
close to 2000, the distribution reports must be filtered and run at 
different times. 

To create Dynamic Address Lists: 

1. Log in to XBRi as a customer Administrator or Manager. 

2. From the Admin menu, choose User Preferences. 

3. Under Settings, choose Dynamic address lists.

4. Click the Add a new dynamic address list link. 

5. Click the Select… link next to Report:. 

6. Navigate to the Shared Reports > Master File Distribution folder. 

7. For each of the reports in the folder, create a dynamic address list by completing the steps that 

follow. 

8. Select the report and click OK. 

9. Enter a name for the list in the Dynamic address list name field. 

10. Under the Required property settings, make sure the correct values are selected. For example, 

for the Property, Physical Address, in a list containing the District attribute, the corresponding 

Value should be District (MFD) (Email). 

Note: the lower portion of the screen under the Subscription mappings, Optional property settings 

is not used in XBRi.  

11. Click Save. 

The new list will be displayed under Dynamic address lists in User Preferences. Repeat steps 8-11 for all 

of the reports in the Master File Distribution folder. 
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Step F: Populate the Master File tables 

To enable the Dynamic address lists you have created, you must first populate the Master File tables 

with a linked user id for each row in the master file. For master files containing over 20 rows of data, you 

must use a batch process. For master files with fewer than 20 rows of data, you can use XBRi Project 

Defaults, Master File Distribution and run the Refresh table option.  

The update process sets up an MFD ‘dummy’ user in the application, and this ID links it to the master 

table for each row. It also creates an associated security filter to limit the data in the emailed report to 

only the one store, one district, etc. 

Note: If a file has more than 20 rows and you try to use the Refresh Table command in Project defaults, 

you will see a message that lets you know the file is too large to process. In that case you must use the 

batch process. 

Before you proceed with this step, be aware that depending on the 
number of records, the batch process can take up to two hours or 
longer to run. 

To populate the linked user id in the Master File tables from Project Defaults: 

1. Log in to XBRi as a customer Administrator. 

2. From the Admin menu, choose Project Defaults. 

3. Under Settings, choose Master File Distribution. 
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4. Select the master table you want to update in the Browse List and click the Refresh table <Table 

name MFD> button. 

To populate the linked user id in the Master File tables using the Batch File Process: 

1. On the server where the MS Iserver is installed, in the XBRi application folder, navigate to the 

batchProcessMFD folder. 

2. Open the init.properties file. 

Example: init.properties file 

#key file 
mr.key.file.name=mr.key 
iserver.name=<Iserver> 
iserver.projectname=<Project name>iserver.port=0 
iserver.login=BBA04229B250CB4B8E74B65E25A2169A 
iserver.password=NA 
useTrusted=true 
tokenPath=C:\\XBRi\\tomcat\\webapps\\analytics\\WEB-INF\\xml\\ 
#DB properties 
db.driver=oracle.jdbc.driver.OracleDriver 
db.url=jdbc:oracle:thin:@WDTVORADBVM1:1521:dwrgqa 
db.login=93B3C6084E4D560252934D6E1965BFD4 
db.password=E72ABA033722D1AEADF6CA9D295AF0CE 

###################################################### 
mfd.org.code=ORA 
excludeTables=MST_STORE;MST_DISTRICT

3. In the init.properties file, edit the IServer and db properties and enter the correct org code. The 

sections to edit are highlighted in the example above. 

4. Use the final line, excludeTables, if you want to exclude tables from the batch process. For 

example, if you already processed one master table, you can exclude it. In the example above, 

the MST_STORE and MST_DISTRICT tables are being excluded from the batch process. 

5. Double click on the mfdupd.bat file. This runs the batch process. 

6. When the batch process has finished, you can check the log file in the batchProcessMFD\log 

folder to make sure it ran correctly. 
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Step G: Using Dynamic Address Lists in Subscriptions 

After you have completed the steps for configuring Master File Distribution, The dynamic address list 

will be available as a new recipient in the Add more recipients TO option when creating and editing 

subscriptions.   

When creating the subscription, the attributes (keys) used to define the master 

file in the project defaults must be in the report or selected in the hierarchy 

prompt used in the subscription. For example, if store and division are selected 

keys, these attributes must be included in the report subscription. 
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Step H: Device IDs in Master Files for Dynamic Address 

lists 

The master tables used for Master File Distribution all have a default device ID. The default device ID 

used for the email system for customer installs is Generic email. The object ID of this device is what is 

being populated in the Device ID column in the master table. You can look up the Device ID 

corresponding to this and all other supported device types in Desktop in the 

<Project>\Administration\Delivery Managers\Devices folder: 

You can right click on a supported device in the list and choose Properties to view the device ID number. 

This ID needs to be populated for each master file entry used in master file distribution. 
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Step I: Change the MFD Key Mappings after the MFD 

Update has been Run 

If you have already run the MFD update and you want to change the MFD keys or Security Filter keys, 

you must follow these steps: 

1. In the Desktop, navigate to the project folders containing MFD Users and MFD Security filters. In 

each folder delete all of the users and filters except: Important! Do not delete the MFD 

001_mfdtemplate in the MFD Users folder or the Security Filter 001_sf_mfdtemplate in the MFD 

Security Filter folder. 

2. Using a database editor, navigate to the master table for which you want to change the mapping 

and delete the linked user ID. 

3. Log in to XBRi as a customer Administrator and change the key columns and security filter 

attributes as in Step C. 

4. Rerun the MFD batch update, as in Step F. 

Step J: Adding New Attributes 

If the customer requires it, you can add new attributes for creating Master File Distribution lists.  

Before you begin 

When you do this it is recommended that you review an MFD table like the one below, and note the 

columns that must be included as attribute forms when you create the new attribute: 

• Email address field–  an email address field to be populated by physical address of the 

user that the email is going to be sent to 

• Linked_User_ ID – to be populated by User GUID that is linked to this recipient. 

• Device_ID – to be populated by GUID of the device object (email device, see Step H of 

this manual) 

Example: 

To create a new MFD attribute: 

1. Log in to Desktop. 

2. Navigate to the Schema Objects > Attributes > Master File Distribution folder. 

3. Click on the New Attribute  icon. 
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4. In the New Attribute Editor, create a new attribute with following attribute forms: 

- Email (map to column Email Address); 

- Linked User Id (map to column Linked_User_ID); 

- Device Id (map to column Device_ID). 

See the image below for an example of an MFD attribute in the New Attribute editor. 

It is strongly recommended to add the suffix, MFD, to the name of the 
attribute, for example District (MFD) so it won’t be confused with 
regular attributes. 

For more information about creating new attributes, consult the XBRi Project Customization guide. 

The new attribute will appear in the Project Defaults Master File Distribution page where the table keys 

and security filter keys are set (see Step C: Verify that key columns and security filter key attributes are 

correct ). 
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Step 16: SSL Configuration 

Prerequisite 

You must have a valid certificate from Certificate Authority (CA). 
To configure the web application to use https protocol: 

1. In the XBRi program folder, locate: \tomcat\conf\server.xml  
2. Edit the server.xml file as follows: 

• If the port 443/8443 is commented, uncomment the whole section of port 443/8443 in the 
server.xml file. 

• Provide the certificate file and password for example:
<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true" 
keystoreFile="/webapps/CERTIFICATEFILENAME" keystorePass="PASSWORD" 
maxThreads="150" scheme="https" secure="true" 

clientAuth="false" sslEnabledProtocols = "TLSv1,TLSv1.1,TLSv1.2"/> 

• Add redirect port for 80/8080 (default port) to secure port 443/8443
<Connector port="8080" protocol="HTTP/1.1" connectionTimeout="20000" 
redirectPort="8443" />  

3. In the XBRi program folder, locate: \tomcat\conf\web.xml file and add or edit the following code: 

<!-- SSL --> 
<security-constraint> 
<web-resource-collection> 
<web-resource-name>securedapp</web-resource-name> 
<url-pattern>/*</url-pattern> 
</web-resource-collection> 
<user-data-constraint> 
<transport-guarantee>CONFIDENTIAL</transport-guarantee> 
</user-data-constraint> 
</security-constraint><security-constraint> 
<web-resource-collection> 
<web-resource-name>Administrator</web-resource-name> 
<url-pattern>/servlet/mstrWebAdmin</url-pattern> 
<url-pattern>/servlet/mstrWebAdmin/*</url-pattern> 
<url-pattern>/servlet/mstrWeb/mstrWebAdmin</url-pattern> 
<url-pattern>/servlet/mstrWeb/mstrWebAdmin/*</url-pattern>  
</web-resource-collection> 
<auth-constraint> 
<role-name>admin</role-name> 
</auth-constraint> 
<user-data-constraint> 
<transport-guarantee>CONFIDENTIAL</transport-guarantee> 
</user-data-constraint> 
</security-constraint> 
<security-constraint> 
<web-resource-collection> 
<web-resource-name>TaskAdministrator</web-resource-name> 
<url-pattern>/servlet/taskAdmin</url-pattern> 
<url-pattern>/servlet/taskAdmin/*</url-pattern>  
</web-resource-collection> 
<auth-constraint> 
<role-name>admin</role-name> 
</auth-constraint> 
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<user-data-constraint> 
<transport-guarantee>CONFIDENTIAL</transport-guarantee> 
</user-data-constraint> 
</security-constraint> 
<security-constraint> 
<web-resource-collection> 
<web-resource-name>TaskDeveloper</web-resource-name> 
<url-pattern>/servlet/taskViewer</url-pattern> 
<url-pattern>/servlet/taskViewer/*</url-pattern>  
</web-resource-collection> 
<auth-constraint> 
<role-name>taskDeveloper</role-name> 
</auth-constraint> 
<user-data-constraint> 
<transport-guarantee>CONFIDENTIAL</transport-guarantee>  
</user-data-constraint> 
</security-constraint> 
<!-- SSL --> 

4. Copy the file containing the CA certificate to the  tomcat\webapps folder. 
Re-start Tomcat from Windows > Services > Apache Tomcat. When you start the application, it 
should automatically be redirected to the https protocol.

If the external site cannot be reached from the web server installation, also complete step 5. 

5. Update the Hosts file to point the internal IP address to both the internal DNS and external DSN 

for correct traffic routing. On the web server, go to C:\Windows\System32\drives\etc. and insert 

a line in the Hosts file for the site configuration, as in the example below: 
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Step 16: LDAP Configuration: 

Creating and Configuring Users 

To create and configure XBRi users: 

1. Navigate to the customer’s LDAP or Active Directory. 

2. Create new users or modify existing users to enable them to connect to XBRi. You must provide 

the following information:  

a) An e-mail address for each user account. 

b) For each user, create a new attribute or edit an existing unused attribute of LDAP user 

to add <Company code_LDAPlogin Id> to the attribute. 

Example 

For the Attribute Uid:  

If the company code is CST and the LDAP User login id is steve, edit the existing attribute 

uid with the value CST_steve.  

<Company code_LDAP login Id> 

Uid = CST_steve 

Company code is established by the Oracle Administrator and must be 
consistent with the Project setup. 

LDAP Security and role assignment and import: 

Defining the security filters on the  LDAP level 
An LDAP Security Filter can be defined on 4 levels: OrgID, Division, District, and Store. If for a selected 
attribute we do not want to create a security filter, then it should be empty, for example, OrgID=.  The 
security filter definition should be included in the group name and assigned to the appropriate user in 
the following format: group name([security filter definition]) 

Example: group A (SF: OrgID=,  Division=3, District=, Store=1; SR: Administrator;) 

The Security Role to be assigned must  match the security role that exists in 

XBRi. The order of parameters defined is important.  

This step is only applicable to those implementations that use LDAP or 
active directory for authentication. After you install XBRi and complete 
the post-installation manual steps, you create or edit XBRi users in the 

customer LDAP or active network directory. Once you have created 
users, you can configure the LDAP server and provide the users’ login 
credentials where prompted. 
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Configuring the LDAP Server 

To configure the LDAP Server: 

1. Log into MicroStrategy Desktop. 

2. Right Click on the Project Source folder and select Intelligence Server Configuration from the 

context menu. 

3. Navigate to the LDAP > Server  page. 

4. Enter the following LDAP Server Information:  

Host = LDAP or Active Directory Server Name 

Authentication User: This user should have administrator privileges to LDAP or 

Active Directory repository and the DN name should be given in DN format. 
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5. Navigate to the LDAP > Platform page. 

6. Select options as shown in the following screen capture: 
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7. Navigate to the LDAP >  Filters page. 

8. Enter the following information:  

Search root distinguished name (DN):  Enter the details of the folder where XBRi

users reside in the LDAP repository. 

User Search Filter: Defaults as shown. 

Group Search Filter: Currently we do not import User groups. This field can be left 

blank or filled as in the screen shot above. 

Test Connection – Click to test the connection after configuring the fields above. 

Login with the value of the user’s LDAP_LOGIN  attribute specified in the user search 

filter above and the user’s LDAP password. See prompt, below: 
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9. Navigate to the LDAP >  Schedules page and select a schedule for the batch import process. 

Users will migrate to “LDAP Users” group in XBRi. 
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10. Navigate to the LDAP >  Import > Import /Synchronize page. 

Select options as shown in the following screen. 
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11. Navigate to the LDAP >  Import > User/Group page.  

Import user Login as – Select the Other: type in value radio button and enter the LDAP 

user attribute configured when you created XBRi users. 

The remaining options on this screen should be left as defaulted. 
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12. Navigate to the LDAP >  Import > Options page.  

Select the Batch import Integrated Authentication/Trusted Authentication unique ID

check box. 

Select the Other: type in value radio button and enter the LDAP user attribute 

configured when you created XBRi users. 

Select the Import email address check box and the Use default LDAP attribute (‘mail’)

radio button. 

Under Address properties select Device “Generic Email” from the drop down. 

Click OK to save changes.  
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Enable LDAP Authentication in the Web Administration Utility 

1. Log into the Web Adminsitration Utility 

(http://WEBSERVERNAME/analytics/servlet/mstrWebAdmin) with the webadmin user and 

password (same login used for creating trusted authentication). 

2.  Click on Default Properties. In the login mode table select LDAP Authentication as shown. 

Optionally, Standard Authentication, may be removed. It is recommended to leave Standard 

enabled until installation is complete. 

3. Save settings and click the MicroStrategy Home icon. The login screen will appear with the LDAP 

Authentication radio button displayed as shown below. 
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Creating and Scheduling the Batch Process 

After creating users and configuring the LDAP server, you must schedule and run the batch process to 

import the users from the LDAP server. Make sure you have the password to open the batch script. 

1. Locate the LDAP folder. 

2. Copy the LDAP folder to the Web Server. 

3. Edit LDAP.scp script using Command Manager (Password required)  

4. Modify the Project Name, user credentials & 3 letter company code in the script. 

5. Save the script. 

6. Edit LDAP.bat and modify the location of LDAP.scp & Logfile path. 

7. Create a Windows Task Schedule to execute the LDAP.bat.  Note: Execute the script after the 

execution on the LDAP-Schedule for importing users from the LDAP user group to the XBRi

Everybody group. 
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Configure Imported Users 

Once the Scheduler executes the batch process (i.e., runs the command manager script), users will 

become available in the Everybody Group in XBRi. The Customer Administrator can login to the 

application and configure imported users for XBRi (assign appropriate user roles, security filters etc.) 

Add ACL (Access Control Entry) on LDAP Users as in the following screenshots  

CST_Administrator       

CST_Users 

XBR Administrators 
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Organization Introduction (New F&B 

Installations Only) 

For Food & Beverage installations, the initial installation introduces the first organization into the 
environment, so up to that point the installations for Retail & Grocery and Food & Beverage are basically 
identical except for the core Access database being duplicated and the initial configuration package. 

Since XBRi 10.8 Food & Beverage sits on top of the mymicros database, which is a multi-tenant database 
with multiple organizations separated by OrganizationID, you must run the Organization Introduction 
module from the installation ISO/DVD for each new organization to be added into XBRi. 

Run Setup.exe from the installation folder, and select Organization Introduction from the drop-down 
list. 
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Select the type of installation:, Food & Beverage or Retail & Grocery from the drop down list: 
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Enter the settings for the Datawarehouse Database. The Database Administrator at the customer site 

can provide these values: 

DW dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

DW dbserver – Enter the data warehouse database server name.

DW dbport – Enter the data warehouse database port number. 

DW dbname – Enter the data warehouse database name. 

DW dbuser – Enter the datawarehouse database user name. 

DW dbpass - Enter the db password in both boxes. This will be encrypted and saved during XBRi

configuration. 

When you are done, click Next. 
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Enter the settings for the Metadata Database. The Database Administrator at the customer site can 
provide these values:

MD dbtype – Select the type of database server from the drop-down list, Oracle or SQL. 

MD dbserver – Enter the metadata database server name.  

If MSSQL DW DB Instance – Enter the database instance if the database server is SQL. 

MD dbport – Enter the metadata database port number. 

MD dbname – Enter the metadata database name. 

MD DB user – This displays the registered user name that was previously entered. 

MD DB PW - This displays the password that was previously entered. This will be used when the 

metadata tables are created.  

When you are done, click Next. 
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Enter the settings for the I-server.  

Server Name – Enter the I-Server name. This is the same name specified in the I-Server 

installation. 

Project Source – Enter the name for the XBRi  project source. 

Project - Enter the name for the XBRi project. 

When you are done, click Next. 
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Enter the customer’s Organizational Settings: 

Webserver Name – Enter the Web Server name. This is the name of the server where you are 

currently doing the install. 

OrgID – The customer number.  

Org Code – The code assigned to the customer by Oracle. 

Customer Name – The name of the customer organization. 

Start Time – Enter the start time for schedules in the format: 00:00 – 23:59. This should be at 

least 15 minutes after the expected ETL completion. If the hour is less than 10, you must include 

a leading zero (09:00). 

When you are done, click Next.
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The installation will now duplicate the project, run the companyCode scripts and execute the org intro 
and cloning stored procedures. 

After this is finished, restart Tomcat. 

Each time the organization introduction process is run, a new Project is duplicated from core, therefore 
all the same Project Configuration steps (after Duplication) must be performed against each new 
organization’s project. In addition to the project configuration, you must also again remove the 
Everyone group from the Normal Users security role for the new organization’s project. 

Remove Everyone Group from Normal Users security role (if exists) 

1. Navigate to Administration\Configuration managers\Security Roles. 

2. Right-click Normal Users security role and select Edit.

3. Select new organization’s project from dropdown. 

4. Remove member group Everyone from right panel and click ok. 

To configure the project: 

1. Log in to MicroStrategy Desktop if not already logged in. 

2. In the XBRi project Source right click on the new project name and select Project Configuration.

3. In the Project Definition - History List page, clear the check box for Save Report Service 

Document dataset messages to history list.

4. Navigate to the Governing rules > Result Sets page. 

Set Wait time for Prompt answer (sec) to 3600 

Set Warehouse execution time (sec) to 3600. 

Set Memory Consumption during SQL generation (MB) to -1. 
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5. Navigate to the Governing Rules > Default > Jobs page and use these guidelines to enter 

the following settings: 

Jobs per user account – Set to 50 

Jobs per session – Set to 50 

Executing jobs per user – Set to 10 

Jobs per project – Limits the number of concurrent jobs that may exist on the I 

server, Recommended settings are:  Small – 1000, Medium – 5000, Large - 50000 

Interactive jobs per project - Set to -1 

Scheduled jobs per project – Set to -1 
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6. Navigate to the Caching >Result Caches> Creation page and clear the Enable report 

server caching check box. 

7. Navigate to the Caching >Result Caches> Storage page. 

Set Cache file directory to .\Caches 

Under Datasets:

Set Maximum Ram usage (Mbytes) to 100/512/2048 (small/medium/large) 

Set “Maximum number of caches to -1 

Under Formatted Documents:  

Set Maximum RAM usage (Mbytes) to one of these values:  100/250/500 

(small/medium/large) 

Set Maximum number of caches to -1 

Clear the Load caches on startup check box. 

8. Click OK, and then click OK in the message that is displayed: 
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This returns you to the Caching – Result Caches – Storage window. 
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9. Navigate to the Caching >Result Caches > Maintenance page, and select the Never 

expire caches check box. 
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10. Navigate to the Caching >Auxiliary Caches>Objects page 

Under Server:  Set Maximum RAM Usage (Mbytes) to 500 

Under Client:  Set Maximum RAM Usage (Mbytes) to 500 
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11. Navigate to the Caching > Auxiliary Caches > Elements page 

Under Server:  Set Maximum RAM Usage (Mbytes) to 500 

Under Client:  Set Maximum RAM Usage (Mbytes) to 500 
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12. Navigate to the Intelligent Cubes > General page. 

Set Maximum % growth of an Intelligent Cube due to indexes to 50 

Set Cube growth check frequency (in mins) to 240 

Clear the Load Intelligent Cubes on startup check box. 

To update the web URL: 

1. Log in to MicroStrategy Desktop. 

2. Right click on XBRi (project Source) and click on Project Configuration.

3. Navigate to Project definition  > Documents and Reports . 
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4. In the two fields under Web Server, enter the URL of the Web Server. 

Example:  

http://WEBSERVER/analytics/servlet/mstrWeb 

or for SSL 

https://WEBSERVER/analytics/servlet/mstrWeb 

Run Date Procedure for New Organization 

After running the Organization Introduction for the new customer, you will need to execute the date 

procedure using the new Organization ID. 

If the customer needs a different date range or uses the fiscal 4-4-5 format, you must follow the next 

procedure to regenerate the data in the master date tables. The parameters in the example below will 

generate the date tables from fiscal 2006 to 2013 with weeks starting on Sunday. 

To regenerate the date tables with a different date range than the fiscal 4-5-4 format:  

Change the parameters as needed. 

In the Query window, enter the following: 

Example: 

BEGIN  

  XBRADMIN.SP_MST_UPD_DATE_454 (1234,'29-JAN-2006',2006,2013,7); 

https://webserver/analytics/servlet/mstrWeb
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  COMMIT;  

END;  

/ 

• The first parameter is the organization ID of the customer 

• The second parameter is the date for the first day of the Fiscal Year according to NRF 
standard 4-5-4 calendar. Years supported are from 2000 to 2031. A 4-5-4 fiscal calendar 
cannot be generated using an invalid fiscal year start date. 

• The third parameter is the fiscal year to start the calendar 

• The fourth parameter is the fiscal year to end the calendar 

• The fifth parameter is the day of the week that starts the fiscal week. The default for the 
U.S. is Sunday, day seven, with Monday being day one. 
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Upgrading an XBRi 10.7 Installation to 

XBRi10.8 

VERY IMPORTANT!! Back up your Mobile images and Mobile configuration 

folders before beginning the upgrade. Failure to do so will result in loss of all 

mobile employee, store and item images placed in the Images folder by the 

customer and the mobile configuration information that was added to the 

configuration folder when the mobile app was configured for the customer.  

Mobile Images folder 

Image folder location 

C:\XBRi\tomcat\webapps\analyticsMobile\images\lpImgs\mobile 

Copy the contents of this folder to a safe location outside of the XBRi 

installation folders. 

Mobile Configuration folder 

Mobile Configuration folder location 

C:\XBRi\tomcat\webapps\analyticsMobile\WEB-INF\xml\mobile 

Copy the contents of this folder to a safe location outside of the XBRi 

installation folders. 

Also copy these 3  files from the XML folder: 

C:\XBRi\tomcat\webapps\analyticsMobile\WEB-INF\xml

AdminServers.xml,  sys_defaults_WEBSERVER and WEBSERVER.token

After the upgrade, copy the contents of the saved folders and the three files 

from the XML folder to the corresponding XBRi folders. 

These instructions for performing an upgrade install assume that the IServer and Web Server are 

installed on the same server. However, it is also possible to install the upgrade in a distributed 

environment where the IServer and Web Server are each on a dedicated Windows 2008r2 server. 

This upgrade assumes your XBRi installation is currently at version 10.7 GA 

If you are upgrading from XBRi 10.7 to 10.8, you will need to upgrade the database: 
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Oracle Database Upgrade – 10.8 to 10.8.1 

Before you begin 

• Upgrade scripts are on the release CD in the following location: 
CD:\DATABASE_SCRIPTS\UPGRADE\ORACLE 

• Ensure your database is currently at XBRi version 10.8 GA, this database upgrade assumes all 
previous upgrades have been completed up through XBRi 10.8 GA 

Upgrade Oracle Database from XBRi 10.8 to XBRi 10.8.1 

3. Run the following scripts in the order shown, “appl” before “data.” 
xbr_appl_108_to_1081_upgrade.sql 

xbr_data_108_to_1081_upgrade.sql 

4. Copy/Paste each entire script into a SQL Query window and execute.  

SQL Database Upgrade – 10.8 to 10.8.1 

Before you begin 

• Upgrade scripts are on the release CD in the following location: 

CD: \DATABASE_SCRIPTS\UPGRADE\MSSQL 

• Ensure your database is currently at XBRi version 10.8 GA, this database upgrade assumes all 
previous upgrades have been completed up through XBRi 10.8 GA 

Upgrade SQL Server Database from XBRi 10.8 to XBRi 10.8.1 

3. Run the following scripts in the order shown, “appl” before “data.” 
xbr_appl_108_to_1081_upgrade.sql 

xbr_data_108_to_1081_upgrade.sql 

4. Copy/Paste each entire script into a SQL Query window and execute.  

In addition, you will need to do the following: 

• Delete the trust relationship 

• Start the Iserver service. 

• Run the Upgrade program which will: 

o Upgrade XBRi Web Application  
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o Upgrade XBRi Utilities – Date Selection and External Scheduler 

o Import Object Manager packages to update project metadata 

• Manually configure the Web Server connection to the IServer and create trust relationship 

Before you continue with the Tomcat and XBRi upgrade, you must delete the Trust Relationship.  

To delete the trust relationship: 

1. In a web browser, go to: https://WEBSERVER/analytics/servlet/mstrWebAdmin.  
2. Log in with the webadmin user and password. 
3. Right click on the connected ISever and choose Properties. 
4. Enter the administrator User ID and Password.  
5. Click Delete Trust Relationship and click Save.  
6. Log out from web and close web browser.  

Run the Upgrade Program 
These instructions assume one Windows server is used for both the IServer and Web Server install. If 

the IServer and Web Server are on separate machines, run the upgrade.exe on the Web server only. 

1. Start the IServer service 

2. From the installation DVD, launch DVD:\XBRiUpgrade\upgrade.exe 

The User Account control confirmation dialog will be displayed. Click Yes to continue. This dialog will be 

displayed and must be confirmed each time  upgrade.exe is launched.  

https://webserver/analytics/servlet/mstrWebAdmin
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Click Next to continue. 
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Select all components: 

CoreDB Upgrade 

Object Upgrade 

Web Server and XBRi Application 

Click Next to continue. 
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Select either Food & Beverage or Retail and Grocery for the upgrade 

Click Next to continue. 
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Name of the Project Source to be Upgraded - Enter  the name of Project Source  

Name of the Project to be Upgraded  -Enter name of the target project to be upgraded 

Org Code - Enter the Customer Code 

dwdb_dbtype.description – Select the database type. 

Iserver Administrator Password - Enter Iserver administrator password  

Click Next to continue. 
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Click Next, and the installation will proceed. 

When the installation is done, click Finish and follow the next steps to refresh intelligent cubes. 

Food & Beverage only 
Repeat the upgrade process for each F&B Customer Project, only selecting Object Upgrade for each 

remaining project. The CoreDB, Web Server and XBRi Application upgrades are server wide and would 

only be redundant while adding additional time to the upgrade process. 

Refresh Cubes 
1. Log into Desktop. 

2. Expand the Administration folder. 

3. Navigate to System Monitors > Caches > Intelligent Cubes. 

4. Verify the Discount Activity, Refund Activity, Sales Analysis, Store Lookup Sales, and Void Activity 

cubes were published successfully and the caches are updated with time of upgrade.  

5. Expand the project folder. 

6. Navigate to Public Objects > Reports > Cubes. 

7. Double click on the cube “Field Dashboard – ICube”  to run it and refresh the Intelligence Cube 

cache. 
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Scheduling daily cube refresh 

To refresh the Intelligence Cubes on a daily basis, set up a Windows Task Scheduler job to run a batch 

command file, i.e.   cube_update.bat with command to launch command manager from the command 

line and run a command manager script, i.e. cube_update.scp with commands to publish each cube, as 

in the example below: 

cube_update.bat 

cmdmgr.exe" -n XBRi -u Administrator -p CoreAdmin12! -f C:\XBRi\cube_update.scp -or 

C:\XBRi\cube_update_results.log -of C:\XBRi\cube_update_fail.log -os 

C:\XBRi\cube_update_success.log –e 

cube_update.scp 

PUBLISH INTELLIGENT CUBE "Field Dashboard - iCube" IN FOLDER "\Public 

Objects\Reports\Cubes" FOR PROJECT "XBRi"; 

... 
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Upgrading an XBRi 10.8 Installation to 

XBRi10.8.1 

VERY IMPORTANT!! Back up your Mobile images and Mobile configuration 

folders before beginning the upgrade. Failure to do so will result in loss of all 

mobile employee, store and item images placed in the Images folder by the 

customer and the mobile configuration information that was added to the 

configuration folder when the mobile app was configured for the customer.  

Mobile Images folder 

Image folder location 

C:\XBRi\tomcat\webapps\analyticsMobile\images\lpImgs\mobile 

Copy the contents of this folder to a safe location outside of the XBRi 

installation folders. 

Mobile Configuration folder 

Mobile Configuration folder location 

C:\XBRi\tomcat\webapps\analyticsMobile\WEB-INF\xml\mobile 

Copy the contents of this folder to a safe location outside of the XBRi 

installation folders. 

Also copy these 3  files from the XML folder: 

C:\XBRi\tomcat\webapps\analyticsMobile\WEB-INF\xml

AdminServers.xml,  sys_defaults_WEBSERVER and WEBSERVER.token

After the upgrade, copy the contents of the saved folders and the three files 

from the XML folder to the corresponding XBRi folders. 

These instructions for performing an upgrade install assume that the IServer and Web Server are 

installed on the same server. However, it is also possible to install the upgrade in a distributed 

environment where the IServer and Web Server are each on a dedicated Windows 2008r2 server. 

This upgrade assumes your XBRi installation is currently at version 10.8 GA 

If you are upgrading from XBRi 10.8 to 10.8.1, you will need to do the following: 

• Upgrade the database as described previously in this guide 
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• Delete the trust relationship 

• Start the Iserver service. 

• Run the Upgrade program which will: 

o Upgrade XBRi Web Application  

o Upgrade XBRi Utilities – Date Selection and External Scheduler 

o Import Object Manager packages to update project metadata 

• Manually configure the Web Server connection to the IServer and create trust relationship 

Before you continue with the Tomcat and XBRi upgrade, you must delete the Trust Relationship.  

To delete the trust relationship: 

1. In a web browser, go to: https://WEBSERVER/analytics/servlet/mstrWebAdmin.  
2. Log in with the webadmin user and password. 
3. Right click on the connected ISever and choose Properties. 
4. Enter the administrator User ID and Password.  
5. Click Delete Trust Relationship and click Save.  
6. Log out from web and close web browser.  

Run the Upgrade Program 
These instructions assume one Windows server is used for both the IServer and Web Server install. If 

the IServer and Web Server are on separate machines, run the upgrade.exe on the Web server only. 

1. Start the IServer service 

2. From the installation DVD, launch DVD:\XBRiUpgrade\upgrade.exe 

The User Account control confirmation dialog will be displayed. Click Yes to continue. This dialog will be 

displayed and must be confirmed each time  upgrade.exe is launched.  

https://webserver/analytics/servlet/mstrWebAdmin
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Click Next to continue. 

.  Select all components 

CoreDB Upgrade 

Object Upgrade 

Web Server and XBRi Application 
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Click Next to continue. 
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Select either Food & Beverage or Retail and Grocery for the upgrade 

Click Next to continue. 
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Name of the Project Source to be Upgraded - Enter  the name of Project Source  

Name of the Project to be Upgraded  -Enter name of the target project to be upgraded 

Org Code - Enter the Customer Code 

dwdb_dbtype.description – Select the database type. 

Iserver Administrator Password - Enter Iserver administrator password  

Click Next to continue. 
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Click Next, and the installation will proceed. 

When the installation is done, click Finish. 

Food & Beverage only 
Repeat the upgrade process for each F&B Customer Project, only selecting Object Upgrade for each 

remaining project. The CoreDB, Web Server and XBRi Application upgrades are server wide and would 

only be redundant while adding additional time to the upgrade process. 

Post Upgrade Configuration 

Food & Beverage only 
Configure projects to add English Custom language component. 

1. Log in to MicroStrategy Desktop if not already logged in. 

2. In the XBRi project Source right click on the project name and select Project Configuration.

3. Expand the Language category. 

4. Click Add button to add languages at lower right of the screen. 
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Select English Custom (United States) under English (United States)  
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Click OK. 

Replace Mobile images and configuration folders saved from before upgrade 

Copy entire folder back to original locations. 

Image folder location 

C:\XBRi\tomcat\webapps\analyticsMobile\images\lpImgs\mobile 

Now copy your mobile configuration folder to safe location outside of installation folders. 

Mobile Configuration folder location 

C:\XBRi\tomcat\webapps\analyticsMobile\WEB-INF\xml\mobile 

Also restore these 3  files back to the XML folder 

AdminServers.xml,  sys_defaults_WEBSERVER and WEBSERVER.token

C:\XBRi\tomcat\webapps\analyticsMobile\WEB-INF\xml 
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Refresh Cubes (if necessary) 
1. Log into MicroStrategy Desktop. 

2. Check the Cubes folder for any cubes with date and time of upgrade, those which were 

upgraded will have the timestamp of the time when the package was imported. You will only 

need to refresh those cubes which have been modified. 

3. To Modify, Expand  Administration folder. 

4. Navigate to System  Monitors > Caches > Intelligent Cubes

5. Ensure the Discount Activity, Refund Activity, Sales Analysis, Store Lookup Sales and Void 

Activity cubes were published successfully and the caches are updated with time of upgrade. 

6. Expand the project folder. 

7. Navigate to Public Objects > Reports > Cubes. 

8. Double click on the cube “Field Dashboard – Icube” to run it and refresh the Intelligence Cube 

cache. 
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Update Database instance for Transaction Reports 

This procedure is for Oracle installations only. 

Follow this procedure for all of the Transaction reports in a folder. 

Right click on the Transaction report and choose Edit. 

This opens the Transaction report. Click the Freeform SQL Definition button. 
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This displays the Freeform SQL window. From the Database Instance drop-down list, select the 

appropriate database instance. 

Click OK and Save and Close. 
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Repeat these steps for every Transaction report in the folder. 
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Create Trusted Authentication 
Start the XBRi Webserver and launch the XBRi URL.  If this is the first time the Webserver is started there 

will be a delay while the war file is un-archived. Login as corexbradmin and then click the Web 

Administrator link. Log in with the webadmin user and password.  

Set up Trusted Authentication 

Under Web Server, navigate to Intelligence Servers > Server. 

Enter the I-Server Name, and click Add. This adds the I-Server to the list under Web Server. 
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Click on the I-Server name and configure the Connection Properties if required. 

Click Connect. 

The IServer is displayed under Connected Servers. Click the properties icon to the right of the page. 
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Click on the IServer name and confirm settings. 
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Set up the Trust Relationship 

1. Select the Standard (user name and password) option. 

2. Enter the MicroStrategy Administrator User Name and Password. 

3. Enter the URL of the Web Server Application. 

4. Click Create Trust Relationship. 
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5. Verify that the Connection properties are OK and click Save. 
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Post Upgrade Step 1: Disable MFD Task and Delete 

Batch File 
After installation you must disable the scheduled MFD task in Windows Task Scheduler and remove the 

MFD batch file from the XBRi application folder. 

Note: This step will not be necessary in the next  installation program that corrects this problem. 

To disable the Master File Distribution process: 

1. From the Web server, open the Task Scheduler. 

2. Navigate to the Task Scheduler library. 

3. Locate the Master File Distribution Process on the tasks list and right click on it. 

4. From the context menu, choose Disable. 

To remove the mfdBatch file: 

1. On the Web server, navigate to the XBRi\batchProcessMFD folder. 
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2. Locate the mfdBatch file and right click on it. 

3. From the context menu, choose Delete. 
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Post Upgrade Step 2: Configure for Master File 

Distribution 

The Master File Distribution feature allows customers to send subscription reports to recipients who are 

not defined users in XBRi. This is done through Dynamic address lists that are derived from reports 

based on the core master tables for Store, District, and Region for Retail installations and District and 

Location for Food and Beverage installations. When you create a dynamic address list, it becomes 

available on the Recipients list for creating email subscriptions. 

The reports used for creating dynamic address lists are stored in the Shared Reports > Master File 

Distribution folder. They include columns for Email, Device ID and Linked User ID. The Device ID column 

is initially populated when the application is installed or when new rows are added to the master files. 

The Linked User ID column is updated in the master files when you run the Master File Batch Update or 

through the application. See Step F: Populate the Master File tables.  

This section contains the steps form enabling master file distribution to using dynamic address lists: 

Step A: Enable Master File Distribution for the project

Step B: Give access to the correct users and groups

Step C: Verify that key columns and security filter key attributes are correct

Step D: Master File Distribution Reports

Step E: Create Dynamic Address Lists

Step F: Populate the Master File tables

Step G: Using Dynamic Address Lists in Subscriptions 

Step H: Device IDs in Master Files for Dynamic Address lists 

Step I: Change the MFD Key Mapping after the MFD Update has been Run 

Step J: Adding New Attributes 

Step A: Enable Master File Distribution for the project 

1. Log in to XBRi as the Core XBRi Administrator. 

2. From the Admin menu, choose Customization Manager. 

3. In the Feature list, select the check box next to Master File Distribution. 

4. Click Apply. 

By default, this feature will be On. 
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Step B: Give access to the MFD feature: 

In the XBRi User Manager, turn on the Master File Distribution feature for the administrator users: 

To give users and groups access to the Master File Distribution feature: 

1. Log in to XBRi as a customer Administrator. 

2. From the Admin menu, choose User Manager. This displays the User Manager. 

• If you want to give access at the group level, click the Edit icon  in the Group row. 

• If you want to give access at the user level, expand the group, and click the Edit icon  in 

the user row. 

3. This displays the Group Editor for a group or the User Editor for a user. 

4. Click the Feature Security tab. 

5. Select the check box next to Master File Distribution. 

6. Click OK. 

By default, this feature will be On. 

Step C: Verify that key columns and security filter key 

attributes are correct 

Several new attributes have been created specifically for Master File Distribution. For Retail, they are 

Store MFD, District MFD and Region MFD. For Food Service, they are District MFD and Location MFD. 

These attributes are used in the reports on which the dynamic address lists are based. See: Step D: 

Master File Distribution Reports. 

After XBRi is installed and MFD is enabled for the project, you need to review the Master File 

Distribution settings in Project Defaults and verify that the MFD mapping matches the key columns for 

each of the master tables. For example, if Store is not unique, Store and Division should be selected as 

keys. 

Also, each of the mappings have a security filter associated with it. The security filter ensures the data 

sent is only for that one store or one district, etc. These also need to be correct for the customer site. If 

not, you can change them using the editing icons in the Project Defaults Master File Distribution page.  
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To verify key columns are correct and modify if needed: 

1. Log in to XBRi as the Core XBRi Administrator. 

2. From the Admin menu, choose Project Defaults. 

3. Under Settings, choose Master File Distribution. 

4. For each table in the Browse List, select the table and click the Define key columns in database 

table  icon. 

Verify that the key columns are correct. If not, you can move a column from the Available to the 

Selected list. 

5. When you are done selecting the key columns, click OK. 

To verify key attributes in the security filter are correct and modify if needed: 

1. Log in to XBRi as the Core XBRi Administrator. 

2. From the Admin menu, choose Project Defaults. 

3. Under Settings, choose Master File Distribution. 

4. For each table in the Browse List, select the table and click the Define key attributes for Security 

Filter icon.  

Verify that the key attributes are correct. If not, you can move an attribute from the Available to 

the Selected list. 

5. When you are done selecting the key attributes, click OK. 

Step D: Master File Distribution Reports 

The reports used for creating dynamic address lists are stored in the Shared Reports > Master File 

Distribution folder. They each contain the MFD attributes that are derived from core master tables for 

Store, District, and Region for Retail installations and District and Location for Food and Beverage 

installations. They include columns for Email, Device ID and Linked User ID. The Device ID column is 



XBRi 10.8.1 Installation Guide 

187

populated when the application is installed or upgraded. The Linked User ID column is updated 

whenever you run the Master File update to populate the Master File tables.  

The dynamic address lists that you create in the next step use the addresses associated with the Linked 

User IDs from the Master File Distribution reports in the Shared Reports > Master File Distribution 

folder.  

Step E: Create Dynamic Address Lists 

The next step is to create Dynamic Address lists for the customer. You create a Dynamic Address list by 

linking it to one of the reports in the Shared Reports > Master File Distribution folder. The emails that 

will be sent are determined by the report to which it is linked. If you need to create a dynamic address 

list with a different MFD report, you will need to create or modify the existing MFD reports. For 

example, you can add a filter to the Store Master File Distribution report to filter for specific stores in 

the Western Region.  

The subscription processing cannot handle more than 2000 users at 
one time. If the master file list of recipient users exceeds or comes 
close to 2000, the distribution reports must be filtered and run at 
different times. 

To create Dynamic Address Lists: 

1. Log in to XBRi as a customer Administrator or Manager. 

2. From the Admin menu, choose User Preferences. 

3. Under Settings, choose Dynamic address lists.

4. Click the Add a new dynamic address list link. 

5. Click the Select… link next to Report:. 

6. Navigate to the Shared Reports > Master File Distribution folder. 

7. For each of the reports in the folder, create a dynamic address list by completing the steps that 

follow. 

8. Select the report and click OK. 

9. Enter a name for the list in the Dynamic address list name field. 

10. Under the Required property settings, make sure the correct values are selected. For example, 

for the Property, Physical Address, in a list containing the District attribute, the corresponding 

Value should be District (MFD) (Email). 

Note: the lower portion of the screen under the Subscription mappings, Optional property settings 

is not used in XBRi.  

11. Click Save. 

The new list will be displayed under Dynamic address lists in User Preferences. Repeat steps 8-11 for all 

of the reports in the Master File Distribution folder. 
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Step F: Populate the Master File tables 

To enable the Dynamic address lists you have created, you must first populate the Master File tables 

with a linked user id for each row in the master file. For master files containing over 20 rows of data, you 

must use a batch process. For master files with fewer than 20 rows of data, you can use XBRi Project 

Defaults, Master File Distribution and run the Refresh table option.  

The update process sets up an MFD ‘dummy’ user in the application, and this ID links it to the master 

table for each row. It also creates an associated security filter to limit the data in the emailed report to 

only the one store, one district, etc. 

Note: If a file has more than 20 rows and you try to use the Refresh Table command in Project defaults, 

you will see a message that lets you know the file is too large to process. In that case you must use the 

batch process. 

Important Before you proceed with this step, be aware that depending on the number of records, the 

batch process can take up to two hours or longer to run. 

To populate the linked user id in the Master File tables from Project Defaults: 

1. Log in to XBRi as a customer Administrator. 

2. From the Admin menu, choose Project Defaults. 

3. Under Settings, choose Master File Distribution. 

4. Select the master table you want to update in the Browse List and click the Refresh table <Table 

name MFD> button. 
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To populate the linked user id in the Master File tables using the Batch File Process: 

1. On the server where the MS Iserver is installed, in the XBRi application folder, navigate to the 

batchProcessMFD folder. 

2. Open the init.properties file. 

Example: init.properties file 

#key file 
mr.key.file.name=mr.key 
iserver.name=<Iserver> 
iserver.projectname=<Project name>iserver.port=0 
iserver.login=BBA04229B250CB4B8E74B65E25A2169A 
iserver.password=NA 
useTrusted=true 
tokenPath=C:\\XBRi\\tomcat\\webapps\\analytics\\WEB-INF\\xml\\ 
#DB properties 
db.driver=oracle.jdbc.driver.OracleDriver 
db.url=jdbc:oracle:thin:@WDTVORADBVM1:1521:dwrgqa 
db.login=93B3C6084E4D560252934D6E1965BFD4 
db.password=E72ABA033722D1AEADF6CA9D295AF0CE 

###################################################### 
mfd.org.code=ORA 
excludeTables=MST_STORE;MST_DISTRICT

3. In the init.properties file, edit the IServer and db properties and enter the correct org code. The 

sections to edit are highlighted in the example above. 

4. Use the final line, excludeTables, if you want to exclude tables from the batch process. For 

example, if you already processed one master table, you can exclude it. In the example above, 

the MST_STORE and MST_DISTRICT tables are being excluded from the batch process. 

5. Double click on the mfdupd.bat file. This runs the batch process. 

6. When the batch process has finished, you can check the log file in the batchProcessMFD\log 

folder to make sure it ran correctly. 

Step G: Using Dynamic Address Lists in Subscriptions 

After you have completed the steps for configuring Master File Distribution, The dynamic address list 

will be available as a new recipient in the Add more recipients TO option when creating and editing 

subscriptions.   

When creating the subscription, the attributes (keys) used to define the master 

file in the project defaults must be in the report or selected in the hierarchy 

prompt used in the subscription. For example, if store and division are selected 

keys, these attributes must be included in the report subscription. 
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Step H: Device IDs in Master Files for Dynamic Address 

lists 

The master tables used for Master File Distribution all have a default device ID. The default device ID 

used for the email system for customer installs is Generic email. The object ID of this device is what is 

being populated in the Device ID column in the master table. You can look up the Device ID 

corresponding to this and all other supported device types in Desktop in the 

<Project>\Administration\Delivery Managers\Devices folder: 

You can right click on a supported device in the list and choose Properties to view the device ID number. 

This ID needs to be populated for each master file entry used in master file distribution. 
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Step I: Change the MFD Key Mappings after the MFD 

Update has been Run 

If you have already run the MFD update and you want to change the MFD keys or Security Filter keys, 

you must follow these steps: 

1. In the Desktop, navigate to the project folders containing MFD Users and MFD Security filters. In 

each folder delete all of the users and filters except: Important! Do not delete the MFD 

001_mfdtemplate in the MFD Users folder or the Security Filter 001_sf_mfdtemplate in the MFD 

Security Filter folder. 

2. Using a database editor, navigate to the master table for which you want to change the mapping 

and delete the linked user ID. 

3. Log in to XBRi as a customer Administrator and change the key columns and security filter 

attributes as in Step C. 

4. Rerun the MFD batch update, as in Step F. 

Step J: Adding New Attributes 

If the customer requires it, you can add new attributes for creating Master File Distribution lists.  

Before you begin 

When you do this it is recommended that you review an MFD table like the one below, and note the 

columns that must be included as attribute forms when you create the new attribute: 

• Email address field–  an email address field to be populated by physical address of the 

user that the email is going to be sent to 

• Linked_User_ ID – to be populated by User GUID that is linked to this recipient. 

• Device_ID – to be populated by GUID of the device object (email device, see Step H of 

this manual) 

Example: 

To create a new MFD attribute: 

1. Log in to Desktop. 

2. Navigate to the Schema Objects > Attributes > Master File Distribution folder. 

3. Click on the New Attribute  icon. 
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4. In the New Attribute Editor, create a new attribute with following attribute forms: 

- Email (map to column Email Address); 

- Linked User Id (map to column Linked_User_ID); 

- Device Id (map to column Device_ID). 

See the image below for an example of an MFD attribute in the New Attribute editor. 

It is strongly recommended to add the suffix, MFD, to the name of the 
attribute, for example District (MFD) so it won’t be confused with 
regular attributes. 

For more information about creating new attributes, consult the XBRi Project Customization guide. 

The new attribute will appear in the Project Defaults Master File Distribution page where the table keys 

and security filter keys are set (see Step C: Verify that key columns and security filter key attributes are 

correct ). 
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Appendix A: Application Configuration 
This section provides instructions on how to do additional configuration that may be required after an 

installation. This will depend on what each customer requires. 

Ensure Security 
To ensure data, system, and application security, whenever possible the Operations team should 
work with XBRi customers to secure access to the servers that run the XBRi Web Server, the 
MicroStrategy Intelligence Server, and the MicroStrategy Administration Desktop. 

Take the following steps to ensure data security: 

1. Make sure that the servers mentioned above are behind the corporate firewall. 
2. Turn off Remote Desktop access to these servers when the access is not needed. 

Add Customer Language Derivatives 
You add customer language derivatives to customize the metadata to use customer-specific 

terminology. 

1. Right-click on the project and select Project Configuration from the context menu. 

2. Navigate to Language > Metadata. 

3. The available languages are listed – in this example, English and Custom English.  Both 

should be selected with English as the default.  The Custom English will be used to display an 

alternative name for an object different from the core name.  For example, a customer may 

want to use the term “Location” instead of “Store”.  The core attribute should not be 

renamed and instead should be translated to “Location” for the Custom English language. 
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Set Project User Language Defaults 

1. Right-click on the project and select Project Configuration from the context menu. 

2. Navigate to Language > User Preferences.

3. Select the new language as the Metadata language preference for all users. Click OK to 

apply the project user default Custom English (United States). 

4. If there were multiple languages on the previous screen, you would click the Modify button 

under the User Language Preferences Manager and assign the default language for each 

user. For this exercise we will assume there is one language.  



XBRi 10.8.1 Installation Guide 

197

5. Change the metadata language for the Administrator account to English (United States) 

Translate Objects to Customer-Specific Naming 

Conventions 

1. Open the project as Administrator. Navigate to the Schema Objects folder and select the 

first object to be translated to the customer- specific naming convention. For this exercise, 

we will translate the “Division” attribute to “Trading Area.”  

2. Navigate to the object and right-click on it.  Select Translate then click the Options button. 
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3. Move Custom English (United States) from the Available Languages to the Selected Edit 

Languages list and Click OK. 

4. Add Trading Area for the Object Name under \ Custom English (United States) and click on 

Save and Close.  

Note: You can also translate Attribute form names, object descriptions, and any additional information. 
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Configuring password complexity and email 

distribution message 
Note: This applies to all customers using the Iserver on which the password complexity is configured. 

To configure password complexity: 

1. In the MicroStrategy Desktop, right click on the project in the Folder list and choose Configure 
MicroStrategy Intelligence Server from the context menu. This displays the MicroStrategy 
Intelligence Server Configuration window.  

2. In the Categories list, expand Server Definition and click Security. 
3. In the Server Definition – Security panel, enter your selections for Account Lockout Policy and 

Password Policy. See image below: 
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To configure the email distribution message: 

The text for the new user email message is stored in the MessagesBundle.properties file on the 

webserver at the following location:  X:\XBRi\tomcat\webapps\analytics\plugins\Help\WEB-

INF\classes\resources\MessagesBundle.properties

1. Open the MessagesBundle.properties file 
2. Use the following variables to configure the message: mr.20136, mr.20137, mr.20138, 

mr.20138, mr.20140, as in the example below: 

mr.20136=Welcome to XBR Ingenium, \#name\#\n\n 

mr.20137=Your login name is \#login\#\n 

mr.20138=Your temporary password is \#password\#\n\n 

mr.20139=You will be prompted to change your password upon your first login. Your new 

password must meet the complexity requirements\: minimum of \#len\# characters, \#uc\# 

uppercase letter, \#lc\# lowercase letter, \#num\# number, and \#spec\# special character.\n\n 

mr.20140=You can access XBR Ingenium using the following URL\: \#url\#\n 
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Configuring Environment type—single tenant vs. 

multi-tenant 
You configure a data warehouse environment as single tenant or multi-tenant by modifying the relevant 

variables. Navigate to your data warehouse database and configure the variables as indicated: 

--set to Single tenant (update 2 rows) 

UPDATE ADM_LP_VARIABLES 

SET    VAR_VALUE    = 'Single' 

WHERE  ORGID        = 1 

  AND  SYSTEM       = '47' 

  AND  VAR_NAME     = 'EnviromentType' 

;  

UPDATE ADM_LP_VARIABLES 

SET    VAR_VALUE    = 'ABC' 

WHERE  ORGID        = 1 

  AND  SYSTEM       = '47' 

  AND  VAR_NAME     = 'DefaultOrgCode' 

;  

--set to Multi-tenant (update 2 row) 

UPDATE ADM_LP_VARIABLES 

SET    VAR_VALUE    = 'Multi' 

WHERE  ORGID        = 1 

  AND  SYSTEM       = '47' 

  AND  VAR_NAME     = 'EnviromentType' 

; 
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Customization Manager 
The Customization Manager can only be accessed by an XBRi Administrator. It is used to enable or 

disable features (customizations) for a server installation and for each organization using the server 

installation.  

• Customizations that are enabled for the server can be enabled or disabled for each customer. 

• When customizations that are disabled by default for the customer are later enabled for the 
customer, they will remain disabled for each user until enabled by the customer administrator 
on the User Manager Feature Security tab. 

• When customizations that are enabled for an organization are disabled in customization 
manager, they will be disabled for all of the organization’s users. 

To enable or disable features for a server installation: 

1. Log in to XBRi as an XBRi Administrator. 
2. Access the Customization Manager from the Admin menu. 
3. From the Apply Settings To drop-down list, select Global. 
4. Select the check boxes next to the features that you want enabled in the server installation and 

clear those that you do not want available. 

To enable or disable features for an organization:  

1. Log in to XBRi as an XBRi Administrator. 
2. Access the Customization Manager from the Admin menu. 
3. From the Apply Settings To drop-down list, select the org code of the customer. 
4. Select the check boxes next to the features that you want enabled for the customer and clear 

those that you do not want available. 
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Security Encryption 
Some sensitive data is encrypted during the installation process, such as account IDs and passwords. You 

can follow this methodology to encrypt or validate other sensitive data as needed. You execute this step 

after completing the Tomcat updates during installation and for the batch processes, 

DateSelectionBatch, lpScheduler, and translation.  For other data types, replace:  

username="ENCRYPTED_USERNAME" password="ENCRYPTED_PASSWORD 

with the correct data type. 

1. On the web server, open the Command prompt. 

2. Go to the Tomcat Lib folder, e.g.,  TOMCAT_HOME_DIR \lib 

3. Execute the following command: 

java -cp MRCrypto.jar com.mr.lp.crypto.MrEncrypt C:\ TOMCAT_HOME_DIR \conf\mr.key 

<DBUSERNAME>    true 

               java -cp MRCrypto.jar com.mr.lp.crypto.MrEncrypt C:\ TOMCAT_HOME_DIR \conf\mr.key 

<DBPASSWORD >   true 

Important: Make sure the key file location is correct for the environment. 

This creates an encrypted string in the command prompt. 

4. Copy the encrypted string referred to above, in the” USERNAME” and “PASSWORD,” section 

under the “Resource name” tag of the analytics.xml and dataeditor.xml files as shown below. In 

addition, add the text in red below: “com.mr.lp.db.crypto.XBRiDataSourceFactory.”  

ANALYTICS XML FILE 

<Resource name="POOL_NAME" auth="Container" 

                type="javax.sql.DataSource" factory="com.mr.lp.db.crypto.XBRiDataSourceFactory" 

                username="ENCRYPTED_USERNAME" password="ENCRYPTED_PASSWORD" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

                url="jdbc:oracle:thin:@HOSTNAME:PORT:DB_NAME" testOnBorrow="true" 

                validationQuery="select count(*) from adm_lp_properties" maxWait="1000" 

                removeAbandoned="true" maxActive="30" maxIdle="10" 

                removeAbandonedTimeout="60" logAbandoned="true" />  

          DATAEDITOR XML FILE    

<Resource name="POOL_NAME" auth="Container" 
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                type="javax.sql.DataSource" factory="com.mr.lp.db.crypto.XBRiDataSourceFactory" 

                username="ENCRYPTED_USERNAME" password="ENCRYPTED_PASSWORD" 

driverClassName="oracle.jdbc.driver.OracleDriver" 

                url="jdbc:oracle:thin:@HOSTNAME:PORT:DB_NAME" testOnBorrow="true" 

                validationQuery="select count(*) from adm_lp_properties" maxWait="1000" 

                removeAbandoned="true" maxActive="30" maxIdle="10" 

                removeAbandonedTimeout="60" logAbandoned="true" />         

5. Restart the Apache Tomcat service. 

LPADMIN Administration 
The LPADMIN account is used for the external scheduler and the date selection batch process. This 

account uses trusted authentication and does not require a password when logging in. However, a 

password for the LPADMIN user must be maintained on the database. There are two steps to 

administering LPADMIN passwords, encrypting the password and configuring it in the 

ADM_LP_VARIABLES table. 

To encrypt an LPADMIN password: 

1. On the web server, open the Command prompt. 

2. Go to the Tomcat Lib folder, e.g.,  TOMCAT_HOME_DIR \lib 

3. Execute the following command: 

java -cp MRCrypto.jar com.mr.lp.crypto.MrEncrypt --\conf\mr.key LPADMIN true 

This generates the encrypted password.  Copy the password so that you can paste it in the 

ADM_LP_VARIABLES table. 

To configure the password in the ADM_LP_VARIABLES table: 

1. On the database server, use the database tool to navigate to the ADM_LP_VARIABLES table.  
2. Display the table rows in editable mode. 
3. Locate the ORGID of the customer for whom you are administering the password. 
4. In the VAR_NAME column, locate admin.password. 
5. In the adjacent VAR_VALUE field, enter the encrypted password from the MrCrypto.jar process 
6. In the VAR_NAME column, locate admin.password.encrypted. 
7. In the adjacent VAR_VALUE field, enter yes. 

Configuring password complexity and email 

distribution message 
Note: This applies to all customers using the Iserver on which the password complexity is configured. 
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To configure password complexity: 

1. In the MicroStrategy Desktop, right click on the project in the Folder list and choose Configure 
MicroStrategy Intelligence Server from the context menu. This displays the MicroStrategy 
Intelligence Server Configuration window.  

2. In the Categories list, expand Server Definition and click Security. 
3. In the Server Definition – Security panel, enter your selections for Account Lockout Policy and 

Password Policy. See image below: 

To configure the email distribution message: 

The text for the new user email message is stored in the MessagesBundle.properties file on the 

webserver at the following location:  X:\XBRi\tomcat\webapps\analytics\plugins\Help\WEB-

INF\classes\resources\MessagesBundle.properties

1. Open the MessagesBundle.properties file 
2. Use the following variables to configure the message: mr.20136, mr.20137, mr.20138, 

mr.20138, mr.20140, as in the example below: 



XBRi 10.8.1 Installation Guide 

206

mr.20136=Welcome to XBR Ingenium, \#name\#\n\n 

mr.20137=Your login name is \#login\#\n 

mr.20138=Your temporary password is \#password\#\n\n 

mr.20139=You will be prompted to change your password upon your first login. Your new 

password must meet the complexity requirements\: minimum of \#len\# characters, \#uc\# 

uppercase letter, \#lc\# lowercase letter, \#num\# number, and \#spec\# special character.\n\n 

mr.20140=You can access XBR Ingenium using the following URL\: \#url\#\n 

Modifying Project Access, modifying XBRi Security 

Access 
Note: If you create a new proto user, you can apply it to just one customer in a multi-tenant 

environment, otherwise, all changes to core proto users will be applied to all customers on the Iserver. 

Privileges and XBRi Security Access should only be modified on Prototype users and the XBRi

Administrators group. But these settings should not be changed. 

See: Create Custom Proto Users and Groups in the Project Customization guide 
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Creating XBRi Administrator Users and best 

practices 
You create a new XBRi Administrator user in the XBRi User Manager. 

To create a new XBRi Administrator user:  

1. Log in to XBRi as an XBRi Administrator.  
2. From the Admin menu, choose User Manager. This displays the User Manager. 
3. Click the New User icon  on the toolbar. This displays the User Editor. 
4. On the General tab, select XBRi Administrator from the Select a User Type drop-down list. 

• An XBRi Administrator can only be created by another XBRi Administrator. 
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• Customers should not be given access to XBRi Administrator users. 

• Make sure that on the Features tab, whatever is enabled for the customer is enabled for the 
XBRi Administrator. 

• XBRi Administrator users have access to objects outside of the project with which they are 
associated. 

• XBRi Administrators creating other users in User Manager should be sure to choose the correct 
org code and user type from the dropdowns on the General tab. 

Modifying, Adding, and Troubleshooting Schedules 
The XBRI OOTB schedules provided for reports, control points, and control groups are created and 

maintained in the MicroStrategy Desktop.   In addition, schedule data must also be maintained in the 

data warehouse table, MD_LP_ES_SCHEDULE table.   These schedules are used to process subscriptions 

at a future date and time such as monthly or weekly as opposed to Run Immediately or Send Now. 

The schedule data maintained in the MD_LP_ES_SCHEDULE table is just for control points and groups 

and only used by the External Scheduler.  When these schedules are selected in a control subscription, 

the External Scheduler is set to poll at 1 minute intervals to look for a time match. When a match is 

found, it will submit the job to the Iserver. The schedule data maintained in the Desktop is for all 

subscription types. In the Desktop, there is a duplicate of each schedule appended with ‘- external ‘that 

is just for control points and groups. The – external schedules correspond to the schedule maintained in 

the MD_LP_ES_SCHEDULE table.  

Modifying Schedules 

If you need to modify a schedule, for example to change the start time, you must make the same 

changes to the schedule time in the MD_LP_ES_SCHEDULE table in the data warehouse. 

To modify a schedule in MicroStrategy Desktop: 

Step 1  

1. Navigate to Administration > Configuration Managers > Schedules. 
2. In the right panel, locate the schedule you want to change, e.g., Daily. Note that there is also a 

Daily – external schedule. 
3. Double click on the schedule that is NOT appended with –external, e.g., Daily. This displays the 

Schedule Wizard. 
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4. Click Next. Do not change the name in the Name field. If you do, you must also change the name 
in the corresponding - external schedule. You can modify the text in the Description if you want 
to reflect the modification. Click Next.  

5. The Time-triggered option should be selected.  

6. Click Next.  Change the start and end dates if you want, and note the changes.   
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7. Click Next. Change the Recurrence settings if you want and note the changes.  
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8. Click Next.  
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9. Click Next. Verify that the changes to the schedule are correct, and click Finish. 
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Note: You do not need to modify the corresponding - external schedule unless you changed the 

Name in step 4. In that case, you need to modify the name in the - external schedule. This is not 

recommended. 

Step 2 – Schedule in Data Warehouse 

After you have modified the schedule in MicroStrategy Desktop, you must look up the schedule in the 

data warehouse and make the same changes to it there.  For example, if you modified the Daily 

schedule in the Desktop to start at 6 AM instead of 7 AM, you must make the same change to the Daily 

schedule in the data warehouse.  

To locate the correct schedule in the data warehouse, you will need the ID of the - external schedule. 

You get this ID from the Properties window in the Desktop. 

To get the external schedule ID: 

1. In the MicroStrategy Desktop, navigate to Administration > Configuration Managers > 
Schedules. 

2. In the right panel, locate the external schedule you changed in the Desktop and need to change 
in the data warehouse, e.g., Daily - external.  

3. Right click on the schedule and choose Properties from the context menu. 
4. In the Properties window, note the ID. This is also the ID of the schedule in the Data Warehouse. 
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To modify the schedule in the data warehouse: 

1. On the database server, use a database tool to navigate to the MD_LP_ES_SCHEDULE table. This 
table contains a row for all of the - external schedules found in MicroStrategy Desktop. 

2. Display the table rows in editable mode. 
3. Look for the schedule recurrence information (e.g., Daily) in the EVENTTYPE column.  
4. Verify that you have the right schedule by looking in the SCHEDULEID field in that row. The ID 

should match the one from the Properties dialog for the - external schedule in the Desktop. 
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5. Edit the properties for the schedule record so that they match the properties for the external 
schedule you modified in the Desktop. For example, if you changed the start time to 6 AM from 
7AM, change the value in the Hour field to 6. In addition to the Hour column, you can change 
the values in these fields to match the values in the schedule you modified in the Desktop: 

Minute – the number of minutes past the hour  

Month – The month in which the schedule should occur. Enter 1-12 for the months from 

January through February. Enter 99 if the schedule occurs in all months. 

Day – the day of the month the schedule occurs. Enter 99 if the schedule occurs in all months 

1-7 – the day of the week on which the schedule occurs, from Sunday through Saturday. Enter a 

1 for each day of the week on which the schedule should occur and a 0 for each day on which it 

should not occur. 

EVENTNAME - TimedEvent 

EVENTTYPE – Modify the information to indicate the new time. 
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Creating New Schedules 

If you want to create a new custom schedule that can be used for subscriptions in XBRi, you need to 

create the schedule and a duplicate - external schedule in MicroStrategy Desktop. You also need to 

enter a new row for the schedule in the MD_LP_ES_SCHEDULE table in the data warehouse.  

Step 1:  create a new schedule in Desktop: 

1. Navigate to Administration > Configuration Managers > Schedules. 
2. From the File menu, choose New > Schedule, or right click in the Schedules folder and choose 

New > Schedule from the context menu. This displays the Schedule Wizard. 
3. Click Next.  Enter a name for the schedule in the Name field. The name should help to identify 

the schedule, for example, Daily. Do not append the name of the first schedule with - external. 
Copy the name and paste it in the Description box.  

4. Click Next.  Select Time-triggered as the schedule type. 
5. Click Next.  Select the start and end dates, and note the selections.   
6. Click Next.  Select the recurrence settings and note the selections.    
7. Click Next. Change the number of dates to display if you want. 
8. Click Next. Verify that the selections for the schedule are correct, and click Finish. 

Step 2:  Create a matching new - external schedule in Desktop: 

Step 2 – external  

1. Navigate to Administration > Configuration Managers > Schedules. 
2. From the File menu choose New > Schedule or right click in the Schedules folder and choose 

New > Schedule from the context menu. This displays the Schedule Wizard. 
3. Click Next.  Enter a name for the schedule in the Name field. The name should be the same as 

the one you entered for the new schedule you just created, appended with   - external, for 
example, Daily - external.  Copy the name and paste it in the Description box.  

4. Click Next.  
5. The Event Triggered option must be selected. Important: Do not select Timed Triggered or you 

will get duplicate subscriptions. 
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6. Click Next.   
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7. Click Next. The TimedEvent option should be selected  
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8. Click Next. Verify that the changes to the schedule are correct, and click Finish. 

Step 3: Add a row for the - external schedule to the MD_LP_ES_SCHEDULE table in the data warehouse. 

After you have created the - external schedule in MicroStrategy Desktop, you must insert a row for it in 

the MD_LP_ES_SCHEDULE table.  This table contains a row for all of the - external schedules created in 

MicroStrategy Desktop. To add the correct schedule in the data warehouse, you will need the ID of the - 

external schedule. You get this ID from the Properties window in the Desktop. 

To get the external schedule ID: 

1. In the MicroStrategy Desktop, navigate to Administration > Configuration Managers > 
Schedules. 

2. In the right panel, locate the external schedule you created in the Desktop, e.g., Daily - external.  
3. Right click on the schedule and choose Properties from the context menu. 
4. In the Properties window, note the ID. This is also the ID of the schedule in the Data Warehouse. 

 After you have the ID, you need to insert a new row in the  MD_LP_ES_SCHEDULE table: 

1. On the database server, use a database tool to navigate to the MD_LP_ES_SCHEDULE table. This 
table contains a row for all of the external schedules created in MicroStrategy Desktop. 

2. Insert a new row with the ID and set up the scheduled time that matches the time of the new 
Time Triggered schedule you created in step 1. 
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Troubleshooting Schedules 

You can trouble shoot control subscription failures by viewing entries in the XBRi\Tomcat\logs 

\stdout.log 

You can look at the jobs to see how the Iserver is processing reports and control point reports in 

MicroStrategy Desktop in the Administration > System Monitors > Jobs folder. 

You can troubleshoot external schedule distribution failures by viewing entries in the esLog.log file 

located in the XBRi application log folder: …XBRi\ExternalScheduler\log folder. 

Sample esLog.log file 
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Creating New Date Prompts with Calendar 

Visualization 
If a customer needs a date prompt for a report that includes custom dates or date ranges, you can 

create a new prompt using four basic steps. 

1. In XBRI, create the new custom date filters and save in a separate folder. 
2. In MicroStrategy Desktop, create a search object to the folder containing the custom filters. 
3. In XBRi create the new prompt, using the search object. 
4. In MicroStrategy Desktop, create a shortcut to the prompt. 

In the new date prompt, options are displayed for each of the folders of date filters. When you select an 

option, the date filters in the corresponding folder are displayed in the drop-down list below. The 

calendar below shows the range of dates selected. 

IMPORTANT: The Date Selection batch process is limited to Date Day and Trans Date attributes, so only 

use those attributes when creating date filters. 

Step 1 Create the new filters 

1. Log in to XBRi as an Administrator.  
2. From the Admin menu, choose Filters. This displays the Filters page. 

3. Click the Create Filter  icon. This displays the Create Filter editor. 
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4. In the pane on the left, navigate to the attribute with the date data type on which you want to 
qualify, for example, Schema Objects > Attributes > Date Periods > Fiscal > Trans Date. 

5. Right-click the attribute and select Add to Filter. This adds the attribute to the left pane, where 
you can further refine it. 

6. Select the Qualify option. 

7. From the first drop-down menu, select the form you want to filter data based on. This is usually 
ID. 

8. From the next drop-down menu, select the operator that describes how you want to filter data. 
If you want to use a data range in your filter, select Between. 

9. In the last field, enter the value(s) or click the calendar to select a date to use to qualify on the 
attribute form. This is the value that will be compared against the data in your data source. 
If you are using a date range in your filter, click the calendar again to select the second date. For 
example, if you want to filter data so the report shows results between January 1 2013 and 
February 12 2013, click the calendar and select January 1 2008, then click the calendar again and 
select February 12 2013. 

10. Click the Apply icon to create your filtering condition. 

11. Click Save As. The Save As dialog box opens. 

12. Navigate to the folder where you want to save the filter. Enter a Name and Description for the 
filter, and click OK. Your new filter is saved.  Note: the folder should be a subfolder of Public 
Objects\Filters\Date Ranges. 

Repeat steps 3-12 for each date filter you want in the prompt and save them to the same folder. 
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Step 2 Create a search object 

1. Log on to the project in the MicroStrategy Desktop. 

2. Click the Search icon  in the toolbar. This displays a Search for Objects dialog. 

3. Enter search criteria to locate the folder of date filters you created. 

4. In the example above, the path to the folder is specified in the Look in field. You can enter this 

path directly, or click the ellipsis button to locate the folder. 

Notes:  

• You check the Include subfolders check box to include all of the subfolders below the folder 

specified in the Look in field. If you want to exclude any of these subfolders, check the 

Exclude Folders checkbox and enter the paths to the subfolders you want to exclude in the 

box below. 

• You can also use the options on the other tabs, such as Date and Object Types to narrow 

your search. 
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The example above shows the Object Types tab with only Filter and Folder selected. 

5. Click the Find Now button. The search results box will display in the lower panel with the 

contents of the folder you specified. 

6. From the file menu choose Save.  

7. Enter a name and location for the search object. This should be the default location for saving 

search objects, e.g., Public Objects\Searches. Remember the name and location, because you 

will use this search object in the new date prompt. 

8. Click the Save button. 

Step 3 Create a prompt 

1. Log in to XBRi as an Administrator.  
2. From the Admin menu, choose Prompts. This displays the Prompt page. 

3. Click the Create Prompt   icon. This displays the Create Prompt page. 
4. Click Object Prompt. This displays the New Prompt editor. 
5. Select the Use the result of a search object option.  
6. Enter the location of the search object you created in step 2, or click the Select Search button 

and look up the search object. 
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7. Click the General tab and enter the prompt name and select prompt options. 

8. Click the Style tab and select style options. 
a. In the Custom Style drop-down list, select CustomPromptObjectWidgetStyle. 
b. Select the Use Folder Structure check box. 
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9. Click Save and enter a name for the prompt, and enter the default prompt folder e.g., Public 
Objects\Prompts. 

Step 4 Create a shortcut to the prompt 

1. Log on to the project in the MicroStrategy Desktop. 

2. Navigate to the folder where you saved the prompt, e.g., Public Objects\Prompts. 

3. In the right panel, right click on the prompt and choose Create Shortcut. This displays Browse 

for folder dialog. 

4. Navigate to Public Objects\Working Folder\Date Selection\Date Selection Prompts. 

5. Click OK. This saves the shortcut in a location where it can be processed by the Date Selection 

batch. 

Note: When you create date selection attributes, the shortcuts are saved to the Date Selection Date 

Attributes folder so they can be processed by the Date Selection batch. 



XBRi 10.8.1 Installation Guide 

228

Verification steps 

The Date Selection batch process must run before the prompt is available to use. You can run this batch 

using the Microsoft Task Scheduler to test the prompt before the next scheduled batch is run. 

To run the Date Selection batch: 

1. Open the Windows Task Scheduler. 
2. Click the Action menu and choose Connect to Another Computer. 
3. Select Another computer and enter the web server name in the field. 
4. Click OK. 
5. In the left panel, select Task Scheduler Library.
6. In the top panel, locate the Date Selection process for you database type, e.g., Date Selection 

ORA. 
7. Right click on it and choose Run from the context menu, or select it and choose Run, under 

Selected Item in the right panel. 
8. The Status will display as Running. When the Status returns to Ready, the prompt is available to 

use in reports, and you can test it in XBRi. 
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Configuring Data Purge Variables 
To enhance data minimization for personal data, a purge process is now configurable for the deletion of 

inactive Customer, Employee and Store personal data. The application will delete data considered to be 

personal data in the database, such as customer and ship to names, addresses, email addresses, etc. 

New settings in pro_sp_variables enable this to be activated when the threshold value reaches the 

number of days defined. The default setting is 370 days for each: 

CUSTOMER_INACTIVE_DAYS - based on number of days since the transaction date that is 

associated with a customer number. Customer First / Last Name, Shipping Address, Email 

Address, Shipping First / Last Name, Phone Number, Zip code, State, Country will be deleted 

from transaction history. 

EMPLOYEE_TERMINATED_DAYS - based on number of days since the termination date set in 

the employee master file. Employee first name, last name, federal ID, and employee image data 

will be deleted from the employee master file. 

STORE_CLOSED_DAYS - based on number of days since the closed date in the store master file. 

Manager name and email address will be deleted from the store master file. 
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Configuring Store & 

Cashier/Employee/Salesperson variables- unique, 

used, size and Customer & SKU Master update 

variables 

Before you do a database upgrade, you need to enter the ETL database settings for these variables in 

the PRO_SP_VARIABLES table. 

IMPORTANT - Remember to set the variable for both VAR_VALUE and VAR_VALUE2 

Cashier Unique in Chain (does not matter if cashiers float between stores) – indicated in 
POS Questionnaire and confirm from content of Employee Master file. 

PRO_SP_VARIABLES.CASHIER_STORE.CASHIER_UNIQUE.VAR_VALUE & VAR_VALUE2 
 If Cashier Number is unique in Store but not unique in Chain, set to ‘N’ 
 If Cashier Number is unique in chain, set to ‘Y’ 

CASHIER_SIZE  
Default is 10.  If the length of the cashier number in tlog and Employee Master are 
shorter than or equal to the default, use the default.  If the cashier number is longer than 
the default, change cashier_size to that length. 

Store Unique in Chain – indicated in POS Questionnaire and confirm from content of tlog 

and Store Master. 

PRO_SP_VARIABLES.CASHIER_STORE.STORE_UNIQUE.VAR_VALUE & VAR_VALUE2 
 If Store Number is unique in Chain, set to ‘Y‘. 
 If Store Number is not unique in Chain, set to ‘N’. 
 If Store Number is not unique in Chain and is unique within division, set to 

‘N’. 

Employee Number Used in Tlog – indicated in POS Questionnaire and confirm from content 

of tlog and Employee Master.  This is true when an employee is the customer for a 

transaction and their employee number is captured and posted in the tlog 

PRO_SP_VARIABLES.CASHIER_STORE.EMPNUM_USED.VAR_VALUE & VAR_VALUE2 

 If employee number field in the tlog is not null for employee sales and 
returns, set to ‘Y’. 

 If employee number field is null in the tlog for employee sales & returns, set 
to ‘N’. 

 Info – the employee number in the employee master is expected to match 
the number in the employee number field in the tlog for employee sales and 
returns. 

Employee Copy from Cashier – indicated in POS Questionnaire and confirm Employee 

Master content.  Employee number refers to the identification of the employee that is 
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posted to the tlog on transactions where the employee is the customer, not the employee 

number from the customer’s HR system. 

PRO_SP_VARIABLES.CASHIER_STORE.EMPLOYEE_COPY.VAR_VALUE & VAR_VALUE2 

 If employee numbers on employee sales can be different from cashier 
numbers, set to N. 

 When a record is added to the employee master as a ‘NOF’ (Not on File) from 
the tlog and the cashier number should be copied to the employee number 
field in the NOF, set to ‘Y’. 

 Info - This flag controls if EMPLOYEENUM and EMPLOYEEID are populated 
with the Cashiernum and CashierID respectively or left NULL by the Not On 
File procedure. 

Salesperson Number Used in Tlog – indicated in POS Questionnaire and confirm from 

content in tlog and Employee Master. 

PRO_SP_VARIABLES.CASHIER_STORE.SALESPERSONNUM_USED.VAR_VALUE & 
VAR_VALUE2 

 If salesperson number can be populated in the tlog for sales and returns, set 
to ‘Y’. 

 If salesperson number is not in the tlog for sales & returns, set to ‘N’. 

Salesperson Copy from Cashier - indicated in POS Questionnaire and confirm from 

Employee Master content. 

PRO_SP_VARIABLES.CASHIER_STORE.SALESPERSON_COPY.VAR_VALUE & VAR_VALUE2 

 If salesperson numbers can be different from cashier numbers, set to N. 
 If salesperson numbers are not used at all, set to N. 
 If the cashier number should be copied to the salesperson number when a 

record is added to the employee master as a ‘NOF’ (Not on File) from the 
tlog, set to ‘Y’. 

 If the salesperson field in the tlog would be populated with the same number 
as the cashier number of the employee, then set to ‘Y’. 

 Info - This flag controls if SALESPERSONNUM and SALESPERSONID are 
populated with the Cashiernum and CashierID respectively or left NULL by 
the NOF procedure. 

Capture Post Void Details in Tlog 
PRO_SP_VARIABLES.PROACT.CAPTURE_PV_DETAILS.VAR_VALUE & VAR_VALUE2 

 If Post Void transactions have the detail lines from the voided transaction, 
set to Y. 

 If Post Void transactions do not have details, set to N. 

Process No Match Return Exchange 
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PRO_SP_VARIABLES.NOMATCH.PROCESS_NM_RETURNEXCH.VAR_VALUE and 
VAR_VALUE2  

 If original transaction STORE, TRANSNUM, REGNUM & DATE for returns are 
in tlog, then set to Y, else N.   

 If customer has more than one POS and one POS captures original 
transaction information for returns and the other POS does not, must be 
discussed with project manager. If we enable Return No Match, the system 
will report a lot of false positives for the POS that does not capture original 
transaction info.   

Capture Original Regnum on Returns 

PRO_SP_VARIABLES.NOMATCH.CAPTURE_ORIG_REGNUM.VAR_VALUE and VAR_VALUE2  
If the tlog captures the original register number for returns, set to Y, else N. 

Process No Match  Post Void & Cancelled 

PRO_SP_VARIABLES.NOMATCH.PROCESS_NM_PVCANCEL.VAR_VALUE and VAR_VALUE2  
If the tlog has Post Voids and/or Cancels, set to Y, else N. 

Post Void Minutes 

PRO_SP_VARIABLES.NOMATCH.PV_MINS  
The number of minutes to look forward to see if a SKU in a post voided 
transaction was re-rung.  Core default is 15. 

Cancel Minutes 

PRO_SP_VARIABLES.NOMATCH.CANCEL_MINS  
The number of minutes to look forward to see if a SKU in a cancelled transaction 
was re-rung.  Core default is 15. 



XBRi 10.8.1 Installation Guide 

233

Sales Threshold 

PRO_SP_VARIABLES.XBRSTATS.SALES_THRESHOLD  
The transaction total tender value for reporting ‘sales less than threshold’.  PM
should be able to provide from customer. Core default is 5.00. 

Pro SP Variables:    SYSTEM / VAR_NAME Default 

Setting 

Customer 

Setting 

Notes 

CASHIER_STORE / CASHIER_UNIQUE N Y If Unique in chain = Y 

CASHIER_STORE / STORE_UNIQUE N Y If Unique in chain = Y 

CASHIER_STORE / EMPLOYEE_COPY Y Y On NOF add, set = cashier  

CASHIER_STORE / EMPNUM_USED Y Y EmpNo on empsale in tlog? 

CASHIER_STORE / SALESPERSON_COPY Y Y On NOF add, set  = cashier 

CASHIER_STORE / 

SALESPERSONNUM_USED 

Y Y Does Customer use?  Is in 

tlog? 

PROACT / CAPTURE_PV_DETAILS Y Y PostVoid Dtl in 

pos_staging.dat? 

NOMATCH / 

PROCESS_NM_RETURNEXCH 

N Y Rtn/Exch has Store, Reg, Txn, 

Date? 

NOMATCH / CAPTURE_ORIG_REGNUM Y Y Rtn/Exch has Orig Reg? 

NOMATCH / PROCESS_NM_PVCANCEL N Y Post Void &/or Cancels in Tlog? 

NOMATCH / PV_MINS 15 15 Min. to look for PV SKU resale 

NOMATCH / CANCEL_MINS 15 15 Min. to look for Cancel SKU 

resale 

XBRSTATS / SALESTHRESHOLD 5 5 Sales less than Threshold 

Value 

CASHIER_SIZE 14 14 Maximum length of 

cashier_num field
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Sales Less than Threshold Variable, Setting and 

Managing Threshold Groups  
Sales Less Than Threshold is an edit criterion for detecting and reporting sale transactions with a non-

zero tender amount below a defined threshold value.   

The system default value for Sales Less Than Threshold is stored in PRO_SP_VARIABLES table with the 

following settings: 

1. SYSTEM = ‘XBRSTATS’,  
2. VAR_NAME = ‘SALES_THRESHOLD’  
3. threshold value in VAR_VALUE (initially set to 5.00).   

This default value should be reviewed with the customer and, if necessary, changed early in the project.     

ABOUT THRESHOLD BASIS AND THRESHOLD GROUPS: 

In XBRi, sales threshold value can be set by country (threshold basis) and a multiple countries can be 

mapped to a single threshold value (threshold group).  Threshold groups provide a single point for 

changing the threshold values of all the countries in the group.  Countries with the same currency could 

logically be in the same threshold group.  There is no reporting by threshold group.  The threshold basis 

of country can be changed to another field in the Store Master, such as state or district.  Multiple bases 

for threshold groups cannot be chosen; e.g.:  calculating Sales Less Than Threshold for both Region and 

District is not allowed.  Only one (1) threshold group basis should be implemented. 

IMPLEMENTING THE COUNTRY THRESHOLD BASIS: 

XBRi offers the ability to have different thresholds for different countries.  To set up threshold groups, 

you need to add the tables PRO_SP_THRESHOLD and PRO_SP_THRESHOLD_MAPPING to the XBRi Data 

Editor, be aware of the contents of the table MST_STORE_TAB and know the customer’s countries and 

threshold value for each country. 

These are the three tables involved in the threshold group implementation: 

PRO_SP_THRESHOLD 

ORGID  NUMBER (10),  

THRESHOLD_ID           NUMBER (3), (maps to THRESHOLD_ID in 

PRO_SP_THRESHOLD_MAPPING) 

THRESHOLD_NAME    VARCHAR2 (30 BYTE), (Name of Threshold Group) 

THRESHOLD_VALUE   NUMBER (10,2)  (threshold value for comparison to sale tender $) 

PRO_SP_THRESHOLD_MAPPING 
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ORGID             NUMBER (10), 

THRESHOLD_ID     NUMBER (3), (maps to THRESHOLD_ID in PRO_SP_THRESHOLD  table) 

SOURCE_VALUE   VARCHAR2 (10 BYTE) (Country code as in Store Master COUNTRY field) 

MST_STORE_TAB 

All other MicroStrategy store columns +  

COUNTRY    (maps to SOURCE_VALUE) 

THRESHOLD_ID   NUMBER(3) (THRESHOLD_VALUE from PRO_SP_THRESHOLD) 

This example shows you how to set up a threshold for COUNTRY.  The threshold values will be added 

into the PRO_SP_THRESHOLD table with a threshold ID, a group name and a threshold value.  The 

countries will be added into the PRO_SP_THRESHOLD_MAPPING table with the country code and the 

corresponding threshold ID.  The countries in the PRO_SP_THRESHOLD_MAPPING table must be the 

same country codes as in the COUNTRY field in the Store master. 

In this example, we will define 2 threshold groups: 

‘USD’, ID 100, threshold 4.00 and  

‘Euro’, ID 200, threshold 3.76  

and the countries that use those thresholds: 

USA (United States) threshold 4.00 

DEU (Germany) threshold 3.76 

FRA (France) threshold 3.76 

To set up a threshold group: 

1. Log in to XBRi as an XBRi administrator. 
2. From the Tools menu, choose Data Editor. This displays the Data Editor > Home page. 
3. Following the procedure To Add Tables to the Data Editor, add the tables, 

PRO_SP_THRESHOLD_MAPPING and PRO_SP_THRESHOLD. 
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4. In the Data Editor > Home page, double click on the link for the PRO_SP_THRESHOLD table. This 
displays the page for the Threshold table. The example below shows the tables with the values 
already entered.   

5. Click the  icon to add a new row. Under THRESHOLD ID, enter 100, under THRESHOLD NAME, 
enter ‘USD’ (no quotes) and under THRESHOLD VALUE, enter 4.00. 

6. Click the  icon to add a new row. Under THRESHOLD ID, enter 200, under THRESHOLD NAME, 
enter ‘Euro’ (no quotes) and under THRESHOLD VALUE, enter 3.76. 

7. If there were additional threshold values to be entered, step 3 would be repeated as needed.  
When you are finished, return to the Data Editor Home page. 

8. In the Data Editor > Home page, double click on the link for the PRO_SP_THRESHOLD_MAPPING 
table. This displays the page for the Threshold Mapping table. The example below shows the 
tables with the values already entered.  

9. Click the  icon to add a new row. Under THRESHOLD ID, enter 100 and under SOURCE VALUE, 
enter ‘USA’ (no quotes). 

10. Click the  icon to add a new row. Under THRESHOLD ID, enter 200 and under SOURCE VALUE, 
enter ‘DEU’ (no quotes). 
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11. Click the  icon to add a new row. Under THRESHOLD ID, enter 200 and under SOURCE VALUE, 
enter ‘FRA’ (no quotes). 

12. If there were additional countries to be entered, step 8 would be repeated as needed.  When 
you are finished, return to the Data Editor Home page. 

13. When the Store Master Update procedure (SP_MST_UPD_STORE) executes, the THRESHOLD_ID 
field in the Store Master will be updated by matching the COUNTRY field in the Store Master to 
the SOURCE_VALUE  field in the PRO_SP_THRESHOLD_MAPPING table and posting the 
THRESHOLD_ID from PRO_SP_THRESHOLD_MAPPING to the THRESHOLD_ID in the Store 
Master.  Continuing the example: 
a. Store 1 in the USA would have a THRESHOLD_ID of 100. 
b. Store 2 in Germany would have a THRESHOLD_ID of 200. 
c. Store 3 in France would have a THRESHOLD_ID of 200. 
d. Stores in other countries would have a NULL THRESHOLD_ID. 

14. When transactions are loaded to history, the store in the transaction record is used to look up 
the THRESHOLD_ID on the Store Master.  The THRESHOLD_ID is used to look up the threshold 
value on the PRO_SP_THRESHOLD table for comparison to the tender amount of SALE 
transactions.  If a store has a NULL THRESHOLD_ID, the system default from PRO_SP_VARIABLES 
is used for the comparison.  The threshold values for the example stores would be: 
e. Store 1 – USA – THRESHOLD_ID 100 – value 4.00. 
f. Store 2 - Germany - THRESHOLD_ID 200 – value 3.76. 
g. Store 3 - France - THRESHOLD_ID of 200 – value 3.76. 
h. Stores  - other countries - THRESHOLD_ID NULL – value 5.00 (system default). 

CHANGING THRESHOLD BASIS: 

If the Threshold Basis or a Threshold value is changed, the change is effective for future processing; 

history is not changed.  If you wanted to set thresholds using a different basis, such as state instead of 

country, the variable in procedure SP_MST_UPD_STORE (code snippet below) would need to be 

changed from “@vs_source_map = ‘COUNTRY’” to “@vs_source_map = ‘'STATE'”, and you would follow 

the procedure above to use the Data Editor to add all the distinct values for state into the threshold 

tables.  

---- Update threshold IDs 

--update MST_STORE_TAB t set threshold_id = (select threshold_id from 

pro_sp_threshold_mapping where source_value=t.country); 

set @vs_source_map = 'COUNTRY' 

select @vs_sql = 'update MST_STORE_TAB set threshold_id = (select 

threshold_id from pro_sp_threshold_mapping where 

source_value=MST_STORE_TAB.'+@vs_source_map+')'
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Configuring Store and Cashier Attributes for the 

Watch List 
The Watch List lets XBRi users assign a watch status to stores or cashiers that they want to monitor. You 

configure the store and cashier attributes for the Watch List by providing valid attribute IDs for 

corresponding Watch Status OBJECT_REF_NAME records in the ADM_LP_PROPERTIES table.  The ID that 

you enter in the DSSID column is obtained from the attribute property in the MicroStrategy Desktop. 

To locate the DSSID for an attribute: 

1. In the MicroStrategy Desktop, navigate to the project folder > Schema Objects > Attributes.  

• To get the DSSID for the OBJECT_REF_NAME, attribute.employee-watch-status, go to the 

Cashier folder and locate the attribute, Cashier Watch Status. 

• To get the DSSID for the OBJECT_REF_NAME, attribute.location-watch-status, go to the 

Store folder and locate the attribute, Store Watch Status. 

2. Right click on each attribute and choose Properties from the context menu. 

3. In the Properties window for each attribute, copy the ID and save to enter in the database. 

To configure the attributes in the database: 

6. On the database server, use the database tool to navigate to the ADM_LP_PROPERTIES table.  
7. Display the table rows in editable mode. 
8. Locate the ORGID of the customer whose project you are configuring. 
9. Locate the OBJECT_REF_NAME records of the stores and cashiers you want to make available 

for the Watch list for that customer. 

• For cashier, the OBJECT_REF_NAME is attribute.employee-watch-status 

• For store, the OBJECT_REF_NAME is attribute.location-watch-status 
10. In the DSSID column, enter the attribute IDs you copied from Desktop.  
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Enabling Attributes for Lookup Administration 
Lookups are values (IDs and descriptions) for selected attributes. These values are stored in the lookup 

table for each attribute, and are used in reporting and for element browsing. The ID represents the 

stored value, i.e. - Tender Type Code or District Number, and the description represents the textual 

description, i.e. - Tender Type Description or District Name. The ID, description, or both may be 

displayed on reporting. XBRi customer administrators have access to the Admin > Project Defaults > 

Lookups page, where they can create and modify lookup values for attributes. Core XBRi administrators 

also have access to a Lookups Administration page where they can add attributes to the list of those 

available on the Lookups page. 

To enable attributes for lookups: 

1. Log in to XBRi as an XBRI  administrator. 
2. From the Admin menu, choose Project Defaults. 
3. Under Settings, click Lookups Administration. This displays the Lookups Administration page. 

4. In the Available list, select an attribute that you want to add, and click the Add  icon. This 
moves it to the Selected list. Repeat this step for each attribute you want to add.  

5. Click Apply. 

Note: You can remove an attribute by selecting it in the Selected list and clicking the Remove  icon. 

The attributes on the Selected list are available for XBRI customer administrators when they go to the 

Lookups page. 
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Enabling Attributes for Smart Links 
Smart Links in XBRi are pop-up reports on attributes that are built from associated attributes. When the 

user hovers over an attribute in a report that has a smart link, this context-sensitive information is 

displayed in a pop-up. When the user moves off the attribute, the report disappears. Customer 

administrators have access to the Smart Links page in Admin > Project Defaults where they can create 

smart links for available attributes and modify existing smart links. Core XBRi administrators can add 

attributes to those available on the Smart Links page using the MicroStrategy Extended Properties 

Editor. 

To add attributes for smart links: 

1. Open the MicroStrategy Extended Properties Editor. 
2. In the Login prompt, make the following selections: 

Select a data source – Select the data source of the project you are working on. 

Select a root object – Select Project 

Authentication mode – Select Standard 

User Name/Password – Enter your Core XBRi administrator credentials 

3. Click the Login button.  
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4. Select the project and click OK. This displays the Object Browser. Navigate to Schema Objects > 
Attributes and locate the folder of the attribute you want to enable for smart links. 

5. Select the attribute that you want to enable for smart links.  
6. In the right panel, right click on lpsmartLinksFlag and choose Edit from the context menu. This 

displays the Property Editor. 
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7.  In the Current Value field, enter Y. 

This adds the attribute to the Available Attributes list in XBRi Admin > Project Defaults > Smart Links. 

Configuring Max Threads and Exceptions for 

Controls 
Control Points are reports that track information on activity performed by a store, cashier, etc., based 

on a defined threshold. An example of this would be a cashier who repeatedly exceeds the threshold 

amount for line discounts. When you run a control point report, it will create results if the values exceed 

the threshold value defined in the report. Those results are called Exceptions. Core XBRi administrators 

can set the number of control point reports that can run simultaneously, and the number of exceptions 

that can be generated by a control point report before a prompt is displayed asking if the user wants to 

see more exceptions. 

1. On the database server, use your frontend database viewer to navigate to the 
ADMIN_LP_VARIABLES table. You can set the parameters for the threads and exceptions 
allowed for controls, by organization. 

2. Display the table rows in editable mode. 
3. In the ORGID column locate the ID of the customer organization. 
4. For the VAR_NAME, CONTROL_MAX_THREADS enter the VAR_VALUE. This is the number of 

control point reports that can be run simultaneously. 
5. For the VAR_NAME, CONTROL_MAX_EXCEPTIONS, enter the VAR_VALUE. This is the number of 

exceptions that can be generated for a control point before an error message is displayed. 



XBRi 10.8.1 Installation Guide 

244

Enable Case Management Integration for a 

Customer 
After running the Upgrade program the final time for Case Management configuration, you can enable 

case management capability for an organization. 

 To enable case management capability in XBRi for an Organization: 

1. Log in to XBR i as an XBR i Administrator user (i.e. CoreXBRAdmin). 

2. From the Admin menu, choose Customization Manager. 

3. Ensure that Global is selected in the Apply Settings dropdown 

4. Place a check in the Case Management check box and click Apply. 

5. From the Apply Settings to drop-down list, ensure that the customer’s project is selected. 

6. Place a check in the Case Management check box and click Apply. 

7. Click OK. 
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Apply Case Management Privileges to Existing 

Users 
Case management privileges can be granted to existing users by a customer administrator. 

To give case management privileges to users: 

1. Log in to XBRi as an administrator. 

2. From the Admin menu, choose User Manager.  

3. In the User Manager, click the Edit icon for a group, if giving privileges to a group, or expand the 

group and click the Edit icon for a user, if giving privileges to a user. 

4. In the Group or User Editor, click the Feature Security tab. 

5. Select the check box next to Case Management. 

6. Click OK. 
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No Match Process and Configuring No Match 

Variables 
Introduction 

The No Match process is performed using the SP_PRO_NOMATCH_RETURNEXCH and 

SP_PRO_NOMATCH_PVCANCEL procedures, which are run from within the SP_PRO_LOAD_HIST 

procedure. These procedures look for original purchase transactions related to refunds and exchanges 

and subsequent re-ring transactions related to post voids and cancels. Based on the results of these 

lookups, Match Codes are assigned. 

IMPORTANT: 

• The SP_PRO_NOMATCH_RETURNEXCH and SP_PRO_NOMATCH_PVCANCEL procedures cannot 

be used in conjunction with the SP_PRO_NOMATCH procedure. The SP_PRO_NOMATCH 

procedure must be deactivated. 

• The No Match procedures do not look at the Balance tables when performing the analysis, nor 

reanalyze if transactions are added to history. 

Enabling/Disabling procedures 

The SP_PRO_NOMATCH_RETURNEXCH and SP_PRO_NOMATCH_PVCANCEL procedures can be enabled 

or disabled with the following entries to the SP_PRO_VARIABLES table: 

system var_name var_value

nomatch process_nm_pvcancel Determines whether the 
SP_PRO_NOMATCH_PVCANCEL procedure is run. 

Y – procedure is run 
N (Default) – procedure is not run 

nomatch process_nm_returnexch Determines whether the SP_
PRO_NOMATCH_RETURNEXCH procedure is run. 

Y – procedure is run 
N (Default) – procedure is not run 

Configuring for original register number (regnum) 

If the original register number used:

When performing a Return or Exchange lookup, if the original register number (regnum) is used, enter Y 

in the var_value field. 

system var_name var_value

nomatch capture_orig_regnum Determines whether the original register number is 
used in the No Match lookups. 

Y – (Default) the original register number is 
used 
N – the original register number is not used 
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If the original register number is not used: 

1. Enter N in the var_value field in SP_PRO_VARIABLES for SYSTEM=’NOMATCH’ and 

VAR_NAME=’CAPTURE_ORIG_REGNUM’ 

2. Extract a copy of the DDL for the POS_SKU view and remove the line in the JOIN 

“AND sku.ORIG_REGNUM = hdr.REGNUM”,  as highlighted below: 

3. Add a new row to PRO_VIEWS for the modified POS_SKU view under the customers ORGID. 

There are now  2 rows, the core -1001 row and the new row just added. 

• For SQL Server, you can use an insert statement 

• For Oracle, you must first compile the view and then run the command 

update pro_views v set syntax = dbms_metadata.get_ddl('VIEW',v.view_name); 

 commit; 

4. Set ACTIVE_FLAG='Y' and CUSTOM_FLAG='Y' on the new row 

5. Set ACTIVE_FLAG='N' on the core -1001 row 
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Returns & Exchanges  

Detail records 

When you run either lookup procedure, one of the following match codes at the detail level is returned:

0 (good) The SKU matches, the return amount is less than or equal to purchase 
price, and the quantity returned is less than or equal to the purchased 
quantity. 

1 (incomplete) One or more of the original transaction fields (orig_storenum, 
orig_regnum, orig_transdate, and orig_transnum) for the returned SKU 
record is null. (orig_regnum is only factored if capture_orig_regnum 'Y'). 

2 (bad) The SKU in the return transaction is not present in the original purchase 
transaction or the original transaction is not found. 

3 (bad) The quantity returned is greater than the quantity in the original purchase 
transaction. 

4 (bad) 
Extended amount returned is greater than the extended amount in the 
original purchase transaction. 

The conditions are evaluated in sequence. For example, if the SKU does not match, the match code will 

be 2 regardless of the amount or quantity. If the SKU matches and the quantity returned is greater than 

what was purchased, the match code will be 3, regardless of the return amount. Match code 4 is only 

used if both the SKU and quantity match, but the extended amount returned is greater than the original 

purchase amount. 

Header Records 

Header records track 'no match' returns and exchanges in a Yes, No, or Incomplete" manner. The match 

codes will be represented as follows: 

0 (good) All returned SKU records at the detail level have match codes of 0. 

1 (incomplete) At least one SKU record has a match code of 1 and no SKU records have a 
match code of 2, 3, or 4. 

2 (bad) At least one SKU record has a match code of 2, 3, or 4. 

Statistics 

The following summary buckets are aggregated using the logic below: 

• REF_EXCH_MO_NOMATCH_COUNT - Transaction count of refund and exchange out transactions 

that have at least one returned SKU identified as 'no match', header match code of 2. 
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• REF_EXCH_MO_NOMATCH_AMOUNT- Sum of net tender amount of refund and exchange out 

transactions that have at least one returned SKU identified as 'no match', header match code of 

2. 
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Cancel Transactions 

Cancel transactions are evaluated to see if the SKU items in the canceled transaction were subsequently 

re-rung in a legitimate purchase transaction in the same store on the same day. 

The number of minutes that the procedure looks forward is set by the following entry in the 

SP_PRO_VARIABLES table: 

system var_name var_value

nomatch cancel_mins Determines how many minutes forward the 
procedure looks for re-rings. 
Default = 15 

Detail records 

Looking at the SKU records of SALE and EXCHANGE transactions with TRANSSTAT = 'CANCEL', 

VOID_CODE = 0, RETURN_FLAG = 'N', and TRAINING_FLAG = 'N', the match codes should be populated in 

the following manner: 

0 (good) SKU was sold in a SALE or EXCHANGE transaction with 
TRANSSTAT = 'COMPLETE', VOID_CODE = 0, RETURN_FLAG = 'N', and 
TRAINING_FLAG = 'N' within X minutes following the time of the cancel. 

1 (bad) SKU was not sold in a SALE or EXCHANGE transaction with 
TRANSSTAT = 'COMPLETE', VOID_CODE = 0, RETURN_FLAG = 'N', and 
TRAINING_FLAG = 'N' within X minutes following the time of the cancel. 

Only SKU, Store, and Trans Date are included in the evaluation criteria. Register, cashier, quantity and 

amount are not included. 

If a cancel transaction does not include SKU detail records, it cannot be evaluated by "no match." 

Header Records 

The match codes at the header level are populated in the following manner: 

0 (good) All cancelled SKU records at detail are populated with a match code of 0. 

1 (bad) At least one SKU record is populated with a match code of 1. 

Statistics 

The following summary buckets are aggregated using the logic below: 
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• CANCEL_NOMATCH_COUNT - Transaction count of cancel transactions that have at least one 

SKU record identified as 'no match', header match code of 1. 

• CANCEL_NOMATCH_AMOUNT - Sum of extended amount + tax amount of cancel transactions 

that have at least one SKU record identified as 'no match', header match code of 1. 

Post Void Transactions 

Like cancels, post void transactions are evaluated to see if the SKU items in the post voided transaction 

were subsequently re-rung in a legitimate purchase transaction in the same store on the same date. 

The number of minutes that the procedure looks forward is set by the following entry in the 

SP_PRO_VARIABLES table: 

system var_name var_value

nomatch pv_mins Determines how many minutes forward the 
procedure looks for re-rings. 
Default = 15 

Detail records 

Looking at the SKU records of post void transactions (TRANSTYPE = 'POSTVOID', TRANSSTAT = 

'COMPLETE', VOID_CODE = 0, RETURN_FLAG = 'N', and TRAINING_FLAG = 'N'), the match codes should 

be populated in the following manner: 

0 (good) SKU was sold in a SALE or EXCHANGE transaction with 
TRANSSTAT = 'COMPLETE', VOID_CODE = 0, RETURN_FLAG = 'N', and 
TRAINING_FLAG = 'N' within X minutes following the time of the post void 
transaction (TRANSTYPE = 'POSTVOID'). 

1 (bad) SKU was not sold in a SALE or EXCHANGE transaction with 
TRANSSTAT = 'COMPLETE', VOID_CODE = 0, RETURN_FLAG = 'N', and 
TRAINING_FLAG = 'N' within X minutes following the time of the post void 
transaction (TRANSTYPE = 'POSTVOID'). 

Only SKU, Store, and Trans Date are included in the evaluation criteria. Register, cashier, quantity and 

amount are not included. 

Header Records 

The match codes at the header level are populated in the following manner: 

0 (good) All post void SKU records at detail are populated with a match code of 0. 

1 (bad) At least one post void SKU record is populated with a match code of 1. 
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Statistics 

The following summary buckets are aggregated using the logic below: 

• POSTVOID_NOMATCH_COUNT - Transaction count of post void transactions that have at least 

one SKU record identified as 'no match', header match code of 1. 

• POSTVOID_NOMATCH_AMOUNT - Sum of extended amount + tax amount of post void 

transactions that have at least one SKU record identified as 'no match', header match code of 1. 



Report Linking – Attribute Form Mapping 

Introduction 

The report linking feature in XBRi lets users create links to relevant target reports or documents from source reports or documents. This lets 

them execute the related report or document by dynamically passing the selected attribute elements from the source, instead of having to run 

another report or document and re-enter the information.  Most of the attribute linking can be done within XBRi by customers, but there some 

configuration steps that can only be done by Oracle Micros administrators.

Linking attributes with different attribute form structures 

There are cases in which a source attribute has different key attribute form structures than the target attribute. For example, the Cash Returned 

SKU Details with Original Info report lists items returned for cash. For each returned item there is an associated Return Orig Trans attribute with 

a single key attribute form: #. The attribute form # provides the Transaction ID of the transaction in which the item was sold.  For each returned 

item, users may want to link to the Transaction Details document to view detailed information concerning the original sale.  
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XBRi Link Editor 

However, the Trans attribute in Transaction Details has six key attribute forms (Version, #, Register, Trans Time, Trans date, Store ID).   
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The ADM_LP_XLINKS_ATTRFORM_MAPPING table provides a mechanism with which to specify how the value of Return Orig Trans’s key 

attribute form # is mapped to a key attribute form in the Trans attribute. 

ADM_LP_XLINKS_ATTRFORM_MAPPING table 
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ADM_LP_XLINKS_ATTRFORM_MAPPING can also be used to support customers if their applications require linking from source attributes to 

target attributes that have different key attribute form structures. 

Link Maintenance Interval 

XBR currently supports preserving some, but not all report attribute link definitions. The scenario below is an example of link definitions that are 

supported. 

Example: Supported link preservation 

Suppose there are two folders, A1 and B1, under the XBRi Core folder.  Also suppose that under folder A1 there is a subfolder A2 that has two 

reports, Report1 and Report2, with a link definition defined from Report1 to Report2.  If users make a copy of folder A2 (together with its 

content) into folder B1, XBRi can preserve the link definition from the new copy of Report1 to the new copy of Report2 independently of 

whether the folder is copied in XBRi or MicroStrategy Desktop. 

XBRi currently supports link preservation as described in the scenario above.  However, there are many ways users may copy folders in 

XBRi.  Furthermore, it is impossible for the XBRi development team to modify MicroStrategy Desktop to capture folder copy events that happen 

in XBRi.  To achieve Link Preservation, XBRi implements a Link Maintenance Interval, e.g., every 20 seconds.  Reports or documents copied within 

the Link Maintenance Interval are considered copies made by a single folder copy operation. 

The default interval value of 20 seconds is chosen because it is long enough so that a report folder copying operation will likely complete in that 

time interval, but short enough so that it is very unlikely that two report folder copying operations would take place within that time interval. 

You can adjust the value of the Link Maintenance Interval by modifying the LINK_MAINTENANCE_INTERVAL_SECS row in the adm_lp_Variables 

table: 
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adm_lp_Variables table 
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Video Linking Configuration 
The video linking feature in XBRi allows users to retrieve the digital video that corresponds to one or more transactions. Video vendors provide 

the video services to customers that are used to record transactions at the point of sale and to display selected video at a later time. 

Code for supported video vendors is included in the SP_PRO_VIDEO procedure that is invoked when user clicks on a video link in the video 

queue. The video queue is in the document that is displayed when a user clicks on the Video Link command in the Tools menu or toolbar in a 

report in which one or more rows with video-enabled attributes are selected. If the customer is using a non-supported vendor, the code for that 

vendor can be added to the SP_PRO_VIDEO procedure.  

There are several other steps for configuring video linking, including associating cameras with registers, specifying attributes for video linking, 

and configuring the ID of the document that is displayed when the user clicks on the Video Link command. 

Before you begin, get the following information from either the customer or the video vendor: 

• Code for the SP_PRO_VIDEO procedure, if the vendor is not supported by XBRi 

• Values for the MST_REGISTER_TAB table: DEVICE_STRING, VIDEO_FLAG, VIDEO_VENDOR and SITECODE (optional if web-based video)  

Step 1: Add a new vendor to SP_PRO_VIDEO 

IMPORTANT: Supported video vendors are already included in the SP_PRO_VIDEO procedure. You do not need to complete this step if the vendor 

appears on the supported vendors list, but this list is subject to change. Check with the account manager or database administrator to see if a 

vendor has been added. 

XBRi supported video vendors 

• 3VR 
• American Dynamics (Intellex) 
• Arrowsight Security 
• AT (Advanced Technology) Video 
• ClickIt 
• Clinton Electronics 
• Dedicated Micros 
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• Exacq Technologies 
• FireKing (Image Vault) 
• FocusMicro 
• Genetec 
• i3 International 
• Kalatel 
• Milestone Systems 
• Mirasys 
• NICE Systems 
• Tyco/Sensormatic 

Note: The video script is launched when the user clicks on the video link in XBRi

To add a video vendor: 

1. Get the SP_PRO_VIDEO procedure from your database Procedures folder and the code specific to the vendor. In this example the vendor 
is CLINTON. 

2. Add an IF statement to existing code for the new vendor. Note: IF statements begin around line 200 to 250. 
For example, if the vendor is Clinton 

if upper (@vs_video_vendor)='CLINTON' 

goto CLINTON 

3. Add the CLINTON code block, just before the GETOUT: label. You can search for this label and create the code block just prior to this label. 
The code block must begin with the new label, which is defined by the GOTO target of the IF statement entered above. The label is the 
GOTO name ended by a colon :  The end of the block must be the statement "GOTO GETOUT". Those are the only standard requirements 
for this procedure, the code between the label CLINTON: and "GOTO GETOUT" is supplied by the video vendor 

Example: SP_PRO_VIDEO script 

CLINTON: 
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-- d:\video\video.exe -s192.168.10.112 -c1 -d10042001 -b17:47:00 -e17:47:30 -uUSERID -pPASSWORD 

-- Video parameters: 

-- -s - store from mst_register_tab where storenum=pn_storenum 

-- -c - camera number from MST_REGISTER_TAB where 

-- storenum=pn_storenum and regnum=pn_regnum 

-- -d - date (mmddccyy) passed pdt_transdate 

-- -b - beginning time (hh:mm:ss) passed ps_start_time 

-- -e - ending time (hh:mm:ss) passed ps_end_time 

-- Uses a dash before the parameter letter 

-- Note the space between parameters in the command line 

-- store and camera already retrieved in beginning 

-- add storenum 

SELECT @vs_video_vendor= VIDEO_VENDOR, @vs_sitecode = SITECODE,@vs_camera = DEVICE_STRING 

   FROM MST_REGISTER_TAB 

WHERE STORENUM = @vn_storenum  

      AND REGNUM = @pn_regnum 

--       AND ORGID = @pn_orgid 
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select @vs_string = @vs_string + '-s ' + @vs_sitecode + ' ' 

select @vs_string = @vs_string + '-c ' + @vs_camera + ' ' 

if @pdt_transdate is not null  

select @vs_string = @vs_string + '-d ' + convert(varchar(12), convert(smalldatetime, @pdt_transdate, 101)) + ' ' 

if @ps_start_time is not null  

select @vs_string = @vs_string + '-b ' + @ps_start_time + ' ' 

if @ps_end_time is not null  

select @vs_string = @vs_string + '-e ' + convert(varchar(10), @ps_end_time) + ' ' 

-- User Name 

select @temp_var = 'user' 

  SELECT @temp_var = VAR_VALUE  

  FROM PRO_SP_VARIABLES 
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 WHERE SYSTEM = @vs_video_vendor 

 AND var_name = 'USERNAME' 

--  AND system_orgid = @pn_orgid 

if @temp_var is not null  

select @vs_string = @vs_string + ' -u ' + @temp_var  

-- Password 

select @temp_var = 'user' 

  SELECT @temp_var = VAR_VALUE  

FROM PRO_SP_VARIABLES 

   WHERE SYSTEM = @vs_video_vendor 

 AND var_name = 'PASSWORD' 

--  AND system_orgid = @pn_orgid 

if @temp_var is not null  

select @vs_string = @vs_string + ' -p ' + @temp_var  
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GOTO GETOUT 

Step 2: Set variables in PRO_SP_VARIABLES 

Several video vendors require specific information,  such as usernames and passwords,  in order to use their services. This general information is 

held within the PRO_SP_VARIABLES table in the XBR Database. These variables must be set before video vendor services can be used. 

In addition to the vendor-specific variables, there are a few general variables that may need to be configured. They are: 

PROACT   REGRECEIPT 

PROACT VIDEO  VIDEO_VENDOR 

PROACT VIDEO  SECONDS PRIOR 

PROACT VIDEO  SECONDS AFTER 

PROACT VIDEO  LENGTH 

The variables that need to be set depend on your video vendor. The following tables detail the information each video vendor requires. Modify 

these rows with your information. If no table exists for your supported video vendor, no configuration of the PRO_SP_VARIABLES table is 

necessary. 
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Step 3: Configure cameras and registers  

The MST_REGISTER_TAB table stores information that maps cameras to registers.  You need to get the following information from the customer 

of video vendor to enter into this table: Values for the MST_REGISTER_TAB table:  

DEVICE_STRING – the camera number  

ACTIVE_FL – Indicates whether the video for the register in enabled, yes (Y) or no (N) 

VIDEO_VENDOR – the video vendor directs the application to call the appropriate video viewer for this store/register combination. 

SITECODE (optional if web-based video) – The IP address for the store’s video system 

To configure cameras and registers: 

1. Log in to XBRi as a core XBRi administrator. 
2. From the Tools menu, choose Data Editor. This displays the Data Editor > Home page. 

3. Click on the Edit icon  in the Action column for the MST_REGISTER_TAB table. 
4. Click the Fields tab. 
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5. For each of these fields: MST_REGISTER_TAB table: DEVICE_STRING, VIDEO_FLAG, VIDEO_VENDOR and SITECODE, click the Edit icon

 in the field row and enter the values provided by the customer or video vendor. 
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Step 4: Configure the attributes for video linking 

You configure the core attributes that are to be enabled for video linking (e.g., Register, Trans Time) and any additional attributes that the 

customer wants enabled for video linking in the ADM_LP_VIDEO_ MAPPING table. When you select a report with video enabled, the Video link 

in the report Tools menu or toolbar is enabled.  

To configure attributes for video linking: 

1. On the database server, use a database tool to navigate to the ADM_LP_VIDEO_MAPPING table. 
2. Enter values in the required fields, as in the examples below: 
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Example 1: Core video attribute mapping 

Core attribute mapping describes the attribute(s) and their associated forms that a report or document needs to have in order for video linking 

to b enabled. 
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Example 2: custom video attribute mapping 
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If customers want to incorporate additional attribute values to be used by the SP_PRO_VIDEO procedure to calculate video invocation 

parameters, they can also use the ADM_LP_VIDEO_MAPPING table.  Notice that the MAPPED field must be MISC and that the MISC_OR field 

must be specified (e.g., 1, 2). 

Step 5: Configure the video link document 

Clicking the Video link displays a document with the transactions in the report and links to video of the transactions and to the video archive. 

You configure this document in the ADM_LP_PROPERTIES table. 

To configure the video link document: 

1. On the database server, use a database tool to navigate to the ADM_LP_PROPERTIES table. 
2. Enter values in the required fields, as in the example below: 

Example : Configuring the video document ID 
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Step 6: Enter the path to the video vendor in Project Defaults 

The Video Configuration Defaults page lets you modify the local paths to the executable files of the video viewers used when executing video 

links. You can also specify the number of seconds before and after the transaction to be included in the video. 

To set video linking project defaults: 
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1. From the Admin menu, choose Project Defaults. 
2. Under Settings, click Video Configuration. This displays the Video Configuration page: 

3. Edit the Path for the Video Vendor if necessary. This sets the local path to the video viewer used when executing a video link. 
4. Change the number of Seconds Before or Seconds After defaults if necessary. This determines the default number of seconds before and 

after the transaction time when generating the start and end times in the Video Queue. 
5. Click Apply. This applies the information and saves it to the ADM_LP_VIDEOCONFIG table. 



Recall Data for Users and Employees 
If requested, you can recall personal data for users and employees from the XBRi database using the SQL 

queries below. 

Note: This applies to Hospitality Implementations only. 

To search for employee details in SQL: 

select * from table(xbri_pii.extract_employee_pii([options])); 

For example, to search for employees with: 

-- First name containing 'rac':  

select * from 

table(xbri_pii.extract_employee_pii(v_firstname=>'rac')); 

-- Last name containing 'art':  

select * from 

table(xbri_pii.extract_employee_pii(v_lastname=>'art')); 

-- First name containing 'rac' and lastname containing 'art': 

 select * from 

table(xbri_pii.extract_employee_pii(v_firstname=>'rac', 

v_lastname=>'art')); 

All options available are: 

-- n_orgid (NUMBER) 

-- v_cashiernum (TEXT) 

-- n_storenum (NUMBER) 

-- n_division (NUMBER) 

-- v_employeenum (NUMBER) 

-- v_firstname (TEXT) 

-- v_lastname (TEXT) 
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To search for user details in SQL: 

select * from table(xbri_pii.extract_user_pii([options])); 

For example, to search for users with: 

-- Name containing 'rac':  

select * from table(xbri_pii.extract_user_pii(v_name=>'rac')); 

-- Login containing 'art':  

select * from table(xbri_pii.extract_user_pii(v_login=>'art')); 

All options available are: 

-- n_orgid NUMBER default null,  

-- v_name NVARCHAR2 default null,  

-- v_login VARCHAR2 default null 
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Troubleshooting 

Configuring database type—Oracle vs. SQL Server  

The database type is populated during the database installation or upgrade procedure. You can verify 

that the correct database is specified by going to the ADM_LP_VARIABLES table and looking at the value 

in line 9, VAR_VALUE. This should be 1 for SQL or 2 for Oracle. 

Validate Case Management Connection Settings in the Data 

Warehouse 

To verify value configuration for case management in the data warehouse: 

1. On the data warehouse server, go to your front-end database tool. 

2. Locate the database instance of your project. 

3. Under the tables folder, locate ADM_LP_Variables. 

4. For the rows with the ORGID of the customer, SYSTEM 28, and VAR_NAME beginning with 

incident., ensure that the values are correct: 

Incident.vendor.app.url = https://appserver1.lpguys.net/microstesting/lpms

Incident.vendor.endpoint = 

https://appserver1.lpguys.net/microstesting/lpms/webservice/dataservice.asmx

https://appserver1.lpguys.net/microstesting/lpms
https://appserver1.lpguys.net/microstesting/lpms/webservice/dataservice.asmx
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Incident.vendor.account = userName 

Incident.vendor.password = userPassword ( encryption via mr.key with 

{tomcat}/lib/MrCrypto.jar ) 

Incident.vendor.password.encrypted = true/false 
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Appendix B: XBR Ingenium Mobile 

Configuration 
You can install the XBR Ingenium app on an iPad or an Android tablet. The app for iPad is available from 

the Apple App Store and the app for Android is available from the Google play app store. The steps that 

follow directly show how the customer can install the app on their mobile device. Prior to installing the 

device, ORACLE must set up the Apple or Android device to connect the XBRi Mobile Server and 

generate the URL for the device, as described in the sections that follow. 

Adding the XBR Ingenium app for iPad: 
Before you begin: locate the e-mail from your customer administrator that contains the URL for the XBRi

Mobile Server. 

You can download XBR Mobile app for iPad directly from Apple App Store.  Follow the steps below to 

download and log in to the app: 

1. On the iPad, tap the App Store icon. 

2. In the Search field, enter XBR (not case sensitive) and tap Search on the keyboard. 

3. Tap the OPEN link. 
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4. At this point, if you have not already, sign in to the Apple App Store.
5. The XBR Ingenium app icon appears on your tablet when it has finished installing.
6. Open the e-mail from your customer administrator that contains the URL for the XBRi Mobile 

Server and copy the URL to the Notes app, which will convert the long URL to a link. 

7. Tap the link to connect to XBRi Mobile Server.  

8. Follow the rest of the instructions in Step 2: Configure the URL on the iPad in the section: 
Generate the URL for the Mobile iPad in this guide. 

This logs you in to the XBRi mobile app. Hereafter, when you click the XBR Ingenium icon,  the saved 

credentials are used and you will not need to re-enter them. 
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Adding the XBR Ingenium app for Android: 
Before you begin: locate the e-mail from your customer administrator that contains the URL for the XBRi

Mobile Server. 

1. On the Android tablet, open the web browser. 
2. In the address bar enter: https://play.google.com. This takes you to the Google Play app store. 
3. In the Search field, enter XBRi (not case sensitive). 

4. Click on the XBR Ingenium app icon. 

5. Click Install. At this point, if you have not already, sign in to the Google Play Store app.
6. In the next prompt, check that the device is correct, and click Install.
7. Click OK. The XBR Ingenium app icon appears on your tablet when it has finished installing.
8. Open the e-mail from your customer administrator that contains the URL for the XBRi Mobile 

Server and tap on the link.
9. Follow the rest of the instructions in Step 2: Configure the URL on the Android Tablet in the 

section: Generate the URL for the Android Tablet in this guide. 

This logs you in to the XBRi mobile app. Hereafter, when you click the XBRi Ingenium icon,  the saved 

credentials are used and you will not need to re-enter them. 

https://play.google.com/
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Setting up an iPad to connect to XBRi Mobile Server 
1. From your desktop or laptop computer, open your  internet browser. 

2. Enter the link to your Web DNS on the XBRi mobile server: 

http://Your_Web_DNS_Name/analyticsMobile/servlet/mstrWebAdmin

example: http://xbrirgdemo.micros-retail.com/analyticsMobile/servlet/mstrWebAdmin

This displays the Mobile Configuration page: 

3. If the Intelligence Server is disconnected, enter your Intelligence Server name in the box 

labeled “Add a server manually” and click connect. 

4. Set up Trusted Connection 

a. Click the properties icon to the right of the page. 

b. Ensure “Automatically connect to Iserver when Mobile Server or Intelligence Server is 

restarted” is selected 

http://your_web_dns_name/analyticsMobile/servlet/mstrWeb
http://xbrirgdemo.micros-retail.com/analyticsMobile/servlet/mstrWeb
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c. Click on the Setup button in the Server Properties panel. 

a. Select the Standard (user name and password) option. 

b. Enter the MicroStrategy Administrator User Name and Password. 

c. Enter the URL of the Web Server Application. 

d. Click Create Trust Relationship. 

5. Verify that the Connection properties are OK and click Save. 
6. Select Mobile Configuration from the left panel. 

7. For the iPad configuration, click the Modify icon  under Actions. 
8. Click the Connectivity Settings tab and enter these settings: 
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Password – Enter administrator password. 

9. Click the  Configure New Mobile Server button and enter these settings: 

Mobile Server name - Web DNS Name, i.e. xbrirgdemo.micros-retail.com 

Mobile Server port – 80 

Mobile Server path - analyticsMobile 
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Mobile Server type - J2EE 

Request Type - HTTP 

Use Default Authentication Mode – Select check box. 

Authentication Mode – Standard 

Login – Leave blank. 

Password – Leave blank. 

10. Click the  Configure New Project button and enter these settings. 

Project Name - Select the project name from drop-down list. 

Use Default Authentication – Clear the check box.  

Authentication Mode – Standard 

Login – Leave blank. 

Password – Leave blank. 

11. In Desktop, unhide the Mobile folder temporarily.  

12. Click the Home Screen tab and select Display a custom home screen. 

13. Click the Security credentials button to the right of the document input box and enter the 

credentials for the administrator account. 

14. Browse to folder: Public Objects\Shared Reports\Mobile\Dashboards\Landing Dashboards and 

select the Mobile Home document 
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15. In Desktop, hide the Mobile folder again. 

16. Click Save. This returns you to the Mobile Configuration page. 
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Generate the URL for the Mobile iPad 

From the Mobile Configuration start page, you need to generate the URL for the iPad that has installed 

the XBRi mobile app. Then you send the URL to the user, who will use the link to log on to the mobile 

server. 

Step 1: Generate and send the URL 

1. Select  the Generate URL  icon under Actions for your configuration. 

2. In the Generate Configuration URL dialog box, select Basic from the Authentication Mode drop-

down list. 

3. Click the Generate URL button. 

4. In the text box below, change the first 4 characters from “mstr” to “xbri”, then  select the entire 

URL, copy it, and paste it into an email message.  Send the message to the iPad user with the 

XBRi Ingenium Mobile app installed. 

Step 2: Configure the URL on the iPad 

1. On the iPad, open the e-mail and copy the URL to the Notes app, which will convert the long 

URL to a link. 

2. Tap the link to connect to XBRi Mobile Server. 

3. Enter your XBRi login credentials, with your User Name  prefixed by your customer code and an 

underscore; e.g.,  for user JSmith and customer XYZ, enter xyz_jsmith. Enter your usual XBRi

password. 
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4. Either tap the GO button on the virtual keyboard, or shrink the keyboard and click OK on the 

login prompt. 

This logs you in to the XBRi mobile app. Hereafter, when you click the XBRi Ingenium icon,  the 

saved credentials are used and you will not need to re-enter them. 
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Setting up an Android Tablet to connect to XBRi

Mobile Server 
1. From your desktop or laptop computer, open your  internet browser. 

2. Enter the link to your Web DNS on the XBRi mobile server: 

http://Your_Web_DNS_Name/analyticsMobile/servlet/mstrWebAdmin

example: http://xbrirgdemo.micros-retail.com/analyticsMobile/servlet/mstrWebAdmin

This displays the Mobile Configuration page: 

3. If the Intelligence Server is disconnected, enter your Intelligence Server name in the box 

labeled “Add a server manually” and click connect. 

4. Set up Trusted Connection 

d. Click the properties icon to the right of the page. 

http://your_web_dns_name/analyticsMobile/servlet/mstrWeb
http://xbrirgdemo.micros-retail.com/analyticsMobile/servlet/mstrWeb
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e. Ensure “Automatically connect to Iserver when Mobile Server or Intelligence Server is 

restarted” is selected 

f. Click on the Setup button in the Server Properties panel. 

e. Select the Standard (user name and password) option. 

f. Enter the MicroStrategy Administrator User Name and Password. 

g. Enter the URL of the Web Server Application. 

h. Click Create Trust Relationship. 

5. Verify that the Connection properties are OK and click Save. 
6. Select Mobile Configuration from the left panel 

7. For the Android Tablet configuration, click the Modify icon  under Actions. 

8. Click the Connectivity Settings tab and enter these settings: 
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Password – Enter administrator password. 

9. Click the  Configure New Mobile Server button and enter these settings: 

Mobile Server name - Web DNS Name, i.e. xbrirgdemo.micros-retail.com 

Mobile Server port – 80 

Mobile Server path - analyticsMobile 
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Mobile Server type - J2EE 

Request Type - HTTP 

Use Default Authentication Mode – Select check box. 

Authentication Mode – Basic 

Login – Enter your XBRi User Name  prefixed by your customer code and an underscore; e.g.,  for 

user JSmith and customer XYZ, enter xyz_jsmith. 

Password – Enter your  XBRi password. 

10. Click the  Configure New Project button and enter these settings: 

Project Name - Select the project name from drop-down list. 

Use Default Authentication – Clear the check box.  

Authentication Mode – Standard 

11. In Desktop, unhide the Mobile folder temporarily.  

12. Click the Home Screen tab and select Display a custom home screen. 

13. Click the Security credentials button to the right of the document input box and enter the 

credentials for the administrator account. 

14. Browse to folder: Public Objects\Shared Reports\Mobile\Dashboards\Landing Dashboards and 

select the Mobile Home document 
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15. In Desktop, hide the Mobile folder again. 

16. Click Save. This returns you to the Mobile Configuration page. 
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Generate the URL for the Android Tablet 

From the Mobile Configuration start page, you need to generate the URL for the Android Tablet that has 

installed the XBRi mobile app. Then you send the URL to the user, who will use the link to log on to the 

mobile server. 

Step 1: Generate and send the URL 

1. Select  the Generate URL  icon under Actions for your configuration. 

2. In the Generate Configuration URL dialog box, select Anonymous from the Authentication 

Mode drop-down list. 

3. Select the Use short URL check box, 

4. Click the Generate URL button. 

5. In the text box below, select the entire URL, copy it, and paste it into an email message.  Send 

the message to the Android Tablet user with the XBRi Ingenium Mobile app installed. 

Step 2: Configure the URL on the Android Tablet 

Note:  The XBR Ingenium app must be installed on the Android tablet to complete this step.  See: Adding 

the XBR Ingenium app for Android for steps to download the app to your Android tablet. 

1. On the Android tablet, open the e-mail and tap the link to connect to XBRi Mobile Server. 
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2. Enter your XBRi login credentials, with your User Name  prefixed by your customer code and an 

underscore; e.g.,  for user JSmith and customer XYZ, enter xyz_jsmith. Enter your usual XBRi

password. 

3. Either tap the GO button on the virtual keyboard, or shrink the keyboard and click OK on the 

login prompt. 

This logs you in to the XBRi mobile app. Hereafter, when you click the XBRi Ingenium icon,  the 

saved credentials are used and you will not need to re-enter them. 
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Troubleshooting 

Dates Display Incorrectly in a Linked Report 
If, after installation, the customer  edits a link to a report, sets the date prompt to Prompt User and 

applys the change, when they run the linked report, and select a different date range, the dates do not 

display properly.  

This problem has occurred with Internet Explorer 9. 

To correct this problem: 

1. Open Internet Explorer 9. 

2. Clear the browser cache of temporary internet files, as in the example below: 

3. From the Tools menu, choose Compatibility View Settings.

4. De-select the Display intranet sites in Compatibility View check box. 
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To: List Does not Populate 
If, after installation, the customer administrator attempts  to create Email subscriptions or Control Point 

Subscriptions  and the To: list does not populate, you can perform one of the following tasks to correct 

the problem: 

From the Desktop: 

Under Administration, select Delivery Managers.  Then select Contacts and refresh it. 

If this is still an issue, then:  

In the Database Server: 

Run this query on the Metadata database to find the disconnect between user and contacts: 

Select DSSMDUSRACCT.LOGIN as ACCOUNT, DSSCSCONTACT.LOGIN as CONTACT  
from DSSMDUSRACCT inner join DSSCSCONTACT on DSSMDUSRACCT.OBJECT_ID= 
DSSCSCONTACT.MSTRUSER_ID  
where DSSCSCONTACT.CONTACT_TYPE = 1 

In the MicroStrategy Integrity Manager: 

1. Launch MicroStrategy Desktop and log in to the target 3-tier project source. 

2. Go to menu > Administration > User Management > User Manager Integrity Checker. 

3. Select all three options and click Start. The window will display the search result. 

4. Click Fix if an error is found. 

New Users Do not Receive E-mails 
If your new users are not receiving e-mails with login and password information after their accounts are 

set up by the administrator, you may have the Always Use Smart Host option checked in the Device 

Editor and the Smart Host is not accessible.  Perform these steps to correct the problem: 

1. Log in to MicroStrategy Desktop. 

2. Click on XBRi (project Source) and click on Administration.

3. Navigate to Delivery Managers > Devices. 

4. Right click on generic email and select Edit from the context menu. 

5. If the Always Use Smart Host option is selected, clear the check box. 
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Smart Links Do Not Work 
If some of the Smart Links that are set to be active after a new install or upgrade do not activate, you 
must re-apply the settings for those smart links in Projects.  

1. Log in to XBRi as the Customer Administrator  
2. From the Admin menu, choose Project Defaults. 
3. Under Settings, choose Smart Links. 

4. Select the attribute category under the Smart Links list and click the Edit  icon. This displays 
a Smart Links editor. 

5. In the Selected box, highlight the smart link that is not working and click the Edit  icon. 
6. If necessary, edit any fields that need to be changed, and then click OK.  
7. Click the Apply button.  

Once you select Apply, the smart link should now work in the reports.  Repeat the steps for any other 
smart links that you need to activate. 

Calendar Visualization in Date Selection Prompts 

are Displaying Incorrect Dates or no Dates 
If you run a report, document or control point and notice that the selected dates on the calendar 

visualization are out of date (for example, if you select Yesterday and the calendar displays the day 

before yesterday), it is likely that the date selection batch process did not run overnight as scheduled.  

To solve this problem, run the date selection batch process in the Windows Task Scheduler manually 

and check the authentication used to run the daily scheduled task. 

To manually run the date selection batch process: 

1. Log into the Windows server and open the Task Scheduler. 

2. Click on the Task Scheduler Library folder . 

3. Right click on the Date Selection Process  task. 

4. Click Run from the context menu. 



                                            XBRi 10.8.1 Installation Guide 

Page | 298 

Linking from the Control Points Exception 

Dashboard does not work 
This problem may occur after an Oracle new installation or upgrade.  

To fix broken linking from the Control Points Exception Dashboard: 

1. Navigate to the Oracle Database. 

2. Insert the following into ADM_LP_VARIABLES: 

(ORGID,SYSTEM,VAR_NAME,VAR_VALUE,VAR_DATATYPE,COMMENTS) VALUES (-

1001,'2','link.execution.oracle.edd.masked.format','yyyy-MM-dd',null,null) 

3. Re-start Tomcat. 

Validate Case Management Connection Settings in 

the Data Warehouse 
To verify value configuration for case management in the data warehouse: 

1. On the data warehouse server, go to your front-end database tool. 

2. Locate the database instance of your project. 

3. Under the tables folder, locate ADM_LP_Variables. 

4. For the rows with the ORGID of the customer, SYSTEM 28, and VAR_NAME beginning with 

incident., ensure that the values are correct: 

Incident.vendor.app.url = https://appserver1.lpguys.net/microstesting/lpms

https://appserver1.lpguys.net/microstesting/lpms
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Incident.vendor.endpoint = 

https://appserver1.lpguys.net/microstesting/lpms/webservice/dataservice.asmx

Incident.vendor.account = userName 

Incident.vendor.password = userPassword ( encryption via mr.key with 

{tomcat}/lib/MrCrypto.jar ) 

Incident.vendor.password.encrypted = true/false 

Security Filter Merge Option for Food Service 

Project Must Be Set to AND 
If the Security Filter Merge option is set to OR for a Food Service project, the store group security filter 

will be ineffective. To solve this problem, ensure that the Security Filter Merge option is set to AND, as in 

the illustration below: 

https://appserver1.lpguys.net/microstesting/lpms/webservice/dataservice.asmx
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Video Link Does Not Connect Successfully with 

Certain JRE Versions 
If customers run into an issue with video linking and certain JRE versions, it is recommended that they 

upgrade to the latest JRE version (certified up to version 55). 

Customers who are running an earlier version of XBRi (prior to 10.7) and run into this issue should 

upgrade to the latest JRE version. They should also add the Analytics Web Server to the Exception Site 

list in the java control panel. 

1. To Add URLs to the Exception Site list: 

Go to the Java Control Panel (On Windows Click Start and then Configure Java) 

2. Click on the Security tab 

3. Click on the Edit Site List button 

4. Click Add in the Exception Site List window 

JRE version 21 is not compatible with any version of XBRi. 

Gauges and Line Graphs Do Not Display on Activity 

Dashboards 
After installation, the gauges and line graphs do not populate on the Activity dashboards until you select 

a block in the heat map. This affects the Void Activity and Discount Activity dashboards for Food & 

Beverage installations, and the Refund Activity, Void Activity, and Discount Activity dashboards for Retail 

installations. This problem occurs in the XBRi application and in the XBR Ingenium app for iPad and 

Android. In order to have the dashboards show the gauges and graphs for each tab for future run times, 

you can select the heat map defaults for each tab and save them. 

To correct this problem, for each dashboard: 

1. Log in as a core XBR Administrator. 

2. Run the dashboard. 

3. Click on an area of the heat map to populate it. For example in the Discount Activity dashboard, 

click on a District in the heat map. 

4. Move to the next tab, for example, Location in an F&B Discount Activity dashboard, and click on 

an area of the heat map to populate it. 

5. Do the previous step for any remaining tabs, for example, Revenue Center in an F&B Discount 

Activity dashboard. 

6. Click Save from the toolbar.  

7. Click OK. 
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